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BLOCK 05 : INSTRUCTIONAL AIDS

INTRODUCTION

In order to bring an effective learning and also to help the students to learn in a
smooth and easy going way, a teacher uses suitable, apt, supportive materials, what are
collectively called Instructional Aids. So, this Bolck focusses on some of the instructional
aids that facilitate a teaching-learning process. In Unit 25 of this Block, a detailed
infromation is given about Text Book; this will be followed by Unit 26, where you
come across the information with reference to work books, charts, models, specimens,
maps and globes. Unit 28 and 29 deal with improvised aids and the last two units,
namely 28 and 29 deal with technology dependent instructional aids and computers as
instructional aids respectively.
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UNIT - 25  ❐❐❐❐❐ TEXTBOOK AS AN INSTRUCTIONAL
     AID

Structure
25.1 Introduction
25.2 Objectives
25.3 Textbook

25.3.1 Meaning and Importance
25.3.2 Characteristics of Textbook
25.3.3 Uses of a Textbook

25.4 Let Us Sum Up
25.5 Answers to ‘Check Your Progress’
25.6 Unit-End Exercises
25.7 References

25.1 Introduction
You know that, every teacher wants to give a very effective learning situation to

the students. Therefore apart from just presenting or imparting the information orally,
a teacher goes in search of other resources and aids that facilitate learning. In this
context, the ‘textbook’ takes up a very conspicuous role. Though the textbook does not
reflect the whole curricular programme, it is considered as almost an inevitable and
integral part. A teacher may feel that, he or she is incapable of teaching in the absence
of textbook. It is true that, in most of the time, the textbook serves as a guide to the
syllabus or becomes the syllabus. Other supplementary reading books, periodicals,
newspapers, science journals, work books, laboratory manuals, teacher’s guide, etc.,
also facilitate the teaching - learning process. In this particular block, you will come to
know about the prominent Instructional Aids.

Usually, in any education system, the objectives will be constructed at the first
step. These objectives will be the means to achieve the broader educational goals and
aims. Based on the objectives, curriculum will be designed and this will be followed
by syllabus construction. Syllabus gives the whole curricular idea in a brief and precise
language. Most of the time, the syllabus is equated with a telegraphic message! Whatever
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that is told in the syllabus in terms of broken sentences will get the relevant expanded
form in a textbook. Let us concentrate on the meaning, nature, importance, characteristics
and advantages of a textbook.

25.2   Objectives
After studying this Unit, you will be able to:

Explain the meaning of a textbook

Understand the importance of a textbook

Identify the characteristics of a textbook

Learn the uses of a textbook.

25.3 Textbook
A textbook is considered as a synonym to syllabus. In any school system, you will

come across three to four types of textbooks. That is to say, all the languages - whether
it is first language, second language or third language will have their own specific
textbooks. The students are supposed to study three languages through the three
respective textbooks. Similarly science textbook and social science textbook are also
there. They could be printed in any medium i.e language according to the requirements
of studies. So, totally there will be the respective textbooks for three languages and
three core subjects at the school level.

The textbook practically describes what should be taught. Therefore, while
prescribing, writing, and selecting a textbook one must be highly cautious. The textbooks
are used chiefly as a source of information, a course of study, a set of unit plans and a
learning guide as well.

25.3.1 Meaning and Importance

Though textbooks are inevitable to teachers now-a-days it is extremely important
on their part to think about the general problems of the textbook, its functions,
characteristics and the methods of using it.

The present-day textbook is usually divided into sections which are again sub-
divided into chapters. Hence, it is perceived that a textbook is a course of study which
may be used in its entirety. A textbook invariably begins with an introductory section,
which sets the stage for the whole year’s programme. The chapters are arranged
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sequentially with a natural continuity of information and give a solid structure for the
classroom academic activity. Along with the printed information, you could see the
photographs and drawings. Each chapters may have several suggestions for
supplementary activities, like, experiments, demonstrations, readings, long term
activities, and short term activities etc;

Few textbooks, supplement the information with materials in boxes, or with
footnotes. The boxes may also contain biographical sketches of scientists or of some of
historians or of some great personalities. Sometimes, you may come across a section
on glossary. Usually a textbook provides a provision for self evaluation. Anyhow,
textbooks tend to be general and comprehensive. They are written for nationwide sale
and therefore deal only with topics of national interest.

All these points explain the meaning and nature of a textbook in general. Now let
its try to focus on the importance of a textbook. The main function of a textbook is to
provide the body of knowledge. It is hence a strong teaching-learning bond between
the teacher and the taught.

As it is already pointed out, it is an extended form of the prescribed syllabi. That
is to say, it is a verbal explanation of the highly abbreviated syllabus. It is a very good
and sound basis for the teacher to generate several learning activities. Through chapter-
end exercises, it gives a scope for self-evaluation to a learner as well as to a teacher.

‘Check Your Progress’-1

Fill in the Blanks

1. The textbook, most of the time plays the role of …………. ( Notes, teacher, syllabus,
student)

2. The textbook is one of the .......................................(instructional aids, books, printed
materials, written documents)

3. A textbook contains ........................at the end of each chapter.

(Self evaluator questions, pictures, photographs, graphs)

25.3.2 Characteristics of Textbook
 Now, if you ask a question to yourself, like “what types of textbook you want?”,

then you will list out all the good characteristics of a textbook. Isn’t it? So, come on,
now, let us do the same task. The characteristics of a good textbook are as follows:
• Textbooks are always in accordance with the aims and objectives of educational

system.
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• Textbooks provide a scope for the development of certain skills. Their skills may
vary with the subjects, like, languages and the core subjects, namely, science,
social science and mathematics.

• The textbook should have good external internal features also. External features
(also known as the mechanical features are nothing but, get up, the quality of the
paper, the printing, photographs, graphs, binding, background sets, etc; - All these
should be attractive and mind catching.

• Internal features are, like, the standard and the method of treatment and presentation
of the subject matter, clarity in the language used, accuracy of the facts, concepts
and principles mentioned, the quality of the supportive diagrams etc.

• The subject matter should be presented in a psychological sequence. It has to
catch the attention of the students, develop interest among them.

• The information within the textbook should reflect the essential criteria, namely,
consistency, reality, etc., It should stand as a device to inculcate certain values,
like, open mindedness, scientific attitudes, scientific method and disciplinary values.

• It should give a chance for the students to carry out certain projects or activities by
good suggestions, so that pupils can understand the subject matter in a better way.

• Each chapter should begin with a brief introduction and end with a fitting summary.

• Each chapter should contain assignments at the end of the chapter with a due
scope for different level of learning, namely, knowledge, understanding, application
and skill.

• All captions and sub-captions must be bold type. The matter should be presented
suitably with a varied and distinctive form.

• Each textbook should be made up of three essential parts, namely

i) Preliminary section

ii) Chapter

iii) Reference Section.

Under preliminary section, it should give the details of sponsoring agency,
government officer, publishers, authors, table of contents and figures. In chapter’s
section, the subject matter has to be printed according to the principles and maxims
of the teaching. In the reference section, glossaries, appendixes must be present.

• The language used in the textbook must be lucid, simple and precise one. It should
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be free from ambiguity, use of double negatives in a sentence etc;

• It should suggest quite a good number of learning activities. It should be in such a
way that, it draws the social community resources and school -society interaction.

• Textbooks of different subjects must bring a strong and positive correlation among
science, craft, social environment and physical environment.

• Each textbook should be accompanied by a teacher’s hand book, work book and
laboratory manuals. (for the science subject).

• The content should be appropriate for the age level and experience background of
the pupils. The concepts should not be too complex for the maturity level of the
pupils.

• The contents should be consistent with the general objectives, goals and aims of
the respective curriculum.

As far as the literary style and vocabulary is concerned, following points have to
be taken care of by the author.

a. Length of sentences

b. Directness of sentences

c. Number of ideas per sentence

d. Continuity of thought.

• The text should have sufficient number of illustrations, clear photographs diagrams,
like, they must be eye-catching.

• The activities at the end of each chapter are to be in such a way that it should meet
the needs of the teacher and the taught.

• A textbook should help to reinforce learning that might have originated in the
class room or laboratory or on the field trip or outside of school. Such reinforcement
should come from self-study and assignment works.

In a nut shell, one can say that, a textbook should be assessed by means of its:

1) Correctness of matter: The subject matter presented in the book must satisfy these
criteria by means of accurate, correct, integrated information.

2) Language and communication: A textbook language must be simple, clear and
lucid in preference. It is good, if the regional textbooks, give the English terminology
within the brackets for certain technical terms.
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3) Simplicity of Diagrams: The diagrams presented in a textbook must be well labeled,
with good proportion in size, so that; students can read the labels comfortably.
Moreover, the diagrams and sketches must be self explanatory, with a bold heading
and relevant foot notes.

4) Quality of Printing and Binding: The paper used to print the contents must be of
a good quality. The binding must give a good get up to the text. The printing also
should be appealing. The subject matter should be sequentially and psychologically
arranged. Headlines and Sub-head lines should be discriminated by a proper ‘font-
size’ and bold letters. It should contain a table of contents at the beginning and a
subject - index at the end. If it is a science textbook, then glossary of some important
scientific terms at the last part of a textbook is a must. So, a good text - book
should satisfy at the above said points as far as possible.

‘Check Your Progress’- 2

State whether the following statements are True / False:

1. One of the external features of a good textbook says that, it should have a   very
attractive get up.

2. The difficulty level of the subject matter in a textbook must be very high.

3. Textbooks help in the formation of goals and aims of a curriculum.

4. There is no need to critically analyse a textbook.

5. The textbooks should have clear explanation good illustrations, appropriate
vocabulary and a good writing style.

25.3.3 Uses of a Textbook

If a textbook satisfies most of the criteria which are listed already, then, it will be
very advantageous to both the teachers as well as the students. So, now let us list
out the uses of a textbook.

• In most of the time, the textbook serves as a guide to the syllabus or constitutes the
syllabus itself.

• It is also true that, a textbook enriches the syllabus, through suggested activities
and suggested readings.

• The primary use of a textbook is that, it is used as one of the instructional aids in
terms of reference, by the teacher as well as the students.
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• It reinforces the learning that might have been occurred in the class room or the
laboratory.

• Textbook, gives the ideas for home assignments, which could be effectively used
by a teacher. The exercises at the end of the each chapter help for giving the drill
work to the students.

• Since textbooks are developed with the common goals and objectives at the national
level, thus they are the best devices in bringing national integrity.

• Textbooks facilitate individualized instruction.

• They are very cheap, economical and accessibility to the users.

• They encourage self-evaluation as well as self - directed activities.

• It will be the major source of information for the students to get prepared for the
examination.

• A textbook knowingly or unknowingly, directly or indirectly keeps the school
activities on a track

• Textbooks are the major source for developing ‘reading - recitation techniques’. -
Here, as the term itself is suggesting, the pupils read a section of the textbook and
then recite their learning. But it should not be overdone.

• A teacher may delegate to a group of pupils, the responsibility for presenting a
section of a textbook unit to their class mates. This is called “pupil presentations
of textbook material”.

• Reading assignments could be given to the students, based on the textbooks.

• Textbooks give quite a good number of illustrations. It also provides many
photographs and diagrams, which could be used for extended discussion and for
further applications.

• Textbooks are also used for summary and review; this is considered as one of the
strongest uses of the textbook

.
‘Check Your Progress’-3

1. The textbook must be assessed from two points of views, they are its

a) Pictures and diagrams

b) Printing and chapter end exercises
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c) Table of contents and index

d) External or mechanical features and internal features

2. The instructional material which forms a strong bond between the teacher and the
taught is

a. Textbook

b. Teacher’s guide

c. Work books

d. None of the above.

3. A textbook must be

a.   Attention catchy

b.   Very light

c. Loaded with information

d Bulky enough

4. Write any two uses of textbooks.

25.4 Let Us Sum Up
Textbook is the most inevitable and integral part in teaching profession. It is

considered as the most important instructional aid. It is an extended form of the whole
syllabus of an academic year. A textbook will be constructed in ccordance with general
aims, goals and objectives of a curriculum. Textbooks are there for three languages and
for three core subjects namely, science, social science and mathematics at secondary
school level. A textbook is the source of information, which throws light on what
should be taught. There are certain criteria, based on which a textbook has to be selected.
Usually textbook will be very general and tend to be comprehensive. Textbooks are
written for a national curriculum. The textbook gives an opportunity for the development
of certain skills, namely, communication skills through language textbooks, observation,
hypothecation and problem solving skills through the science, social science and
mathematics textbooks.

A typical textbook must satisfy the criteria of external or mechanical features as
well as internal features. Outward get up, its binding, quality of the paper, colour - etc;
constitute the external or mechanical features of a textbook. Similarly, the subject matter
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presented inside the textbook, the accuracy, clarity, of the information, its consistency,
clarity in sketches, and diagrams, lucid, simple, meaningful sentences etc; all these
constitute the internal features.

To have a good textbook in an educational system is really advantageous as it is
used in several ways. Most of the times it serves as a guide to the teacher, by enriching
the syllabus. It makes a pupil to get prepared well for the examination. They are the
best devices in bringing national integrity. Based on the textbook exercises a teacher
can design several drill works as well as an array of home assignments.

25.5 Answer to ‘Check Your Progress’
‘Check Your Progress’ - 1
1. Syllabus
2. Instructional aids
3. Self-evaluatory questions

‘Check Your Progress’ - 2
1. True
2. False
3. False
4. False
5. True

‘Check Your Progress’ - 3
1. d) External or mechanical features and internal features
2. a) Text book

3. a) Attention catchy

4. Write any two used from section 25.3.3

25.6 Unit-End Exercises
1. What is a textbook? Explain its meaning and importance.
2. Explain the need of a textbook
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3. List out the characteristic features of a good textbook.

4. Mention the uses of a textbook.

25.7   Reference
1. Walter A. Thurber and Alfred T. Collette, Teaching Science in Today’s Secondary

Schools - II Edition (1964)

2. Nathan. S. Washington, Teaching Science Creatively, Saunders Science Teaching
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4. Yadav. K., Teaching of Life Sciences, Anmol Publications Pvt. Ltd. New Delhi
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UNIT - 26   ❐   ❐   ❐   ❐   ❐   OTHER INSTRUCTIONAL AIDS

Structure
26.1 Introduction

26.2 Objectives

26.3 Work Book - Meaning, Types, Selection, Preparation, Usage

26.4 Charts - Meaning, Types, Selection, Preparation, Usage

26.5 Models - Meaning, Types, Selection, Preparation, Usage

26.6 Specimens - Meaning, Types, Selection, Preparation, Usage

26.7 Maps and Globes - Meaning, Types, Selection, Preparation, Usage.

26.8 Let Us Sum Up

26.9 Answers to ‘Check Your Progress’

26.10 Unit-End Exercises

26.11 References

26.1 Introduction
A very enthusiastic teacher will always put sincere efforts to bring about qualitative

learning among the students. For that many teaching strategies, tactics, skills are used.
The strategies may include the teacher’s role as well as some material’s role. Since
these materials help in the learning of the subjects that are imparted during teaching,
they are called instructional aids. In the previous unit, you have come across one of the
very important instructional aids, i.e. Textbook. In this unit, you will come to know
about other instructional aids which facilitate the teaching learning session.

A child centered approach in any teaching situation, gives a pivotal place for the
pupil’s participation. It anticipates his learning to be the resultant of his personal
experience. This is, what is known as first hand experience. But in certain cases, such
learning is obviously not possible. Take, for example, a physics student cannot see
what goes on inside a vacuum tube, or a biology student cannot sit patiently watching
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bud while it opens or you cannot take the whole class near the Taj Mahal. In such
situations, a teacher must use the substitutes for reality - like, photographs, drawings,
models, recordings, CD’s etc., Generally such substitutes are termed as audio - visual
aids. It is because these learning aids capture the most important sense organs, eyes
and ears. It is also true that they help in the learning of instructions or what is taught.
Hence they are also grouped under the category what is known as instructional aid. The
first and the foremost place occupied by the instructional aid, will be the textbook.
This you have already learnt in the previous unit.

Next, the textbook has to be followed by teacher’s guide, work books, laboratory
manuals etc; as the integral parts in a curriculum. NCERT has taken a very strong step
in this direction. The textbooks should be accompanied by work books. So, in this
particular unit, we shall concentrate on work books which are followed by details
regarding, charts, models, specimens, maps and globes - which are collectively called
audio - visual aids. In all these cases, we shall go by their meaning, types, selection,
preparation and usage.

26.2 Objectives
After studying this unit, you will be able to:

Explain the meaning and nature of work book

List out the characteristic features of a good chart

Mention the criteria for the selection of models.

Describe the procedures for the preparation of specimens

Grasp the need for the use of maps and globes.

Enumerate the general principles for the selection of instructional aids.

26.3 Work Book - Meaning, Types, Selection, Preparation and
Usage

A work book is a printed device, which is produced as a supportive material for
the already established textbook. This implies that, it exactly follows the textbook
information. Most of the time a work book is used as an instrument for evaluation. At
its best appearance, a work book can become an academic record, a summerisation of
learning, an exercise in organisation, a medium for self - expression, an indication of
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progress and a more dynamic book for giving chance of ‘then and there’ expression.
Here the students have to read and write or respond on the concerned page itself. In this
respect, a work book supplements the textbook. Though the students come across the
questions, and exercises at the end of each chapter, they are not expected to write their
answers on that same page. This criterion is fulfilled in a work book. Therefore a
workbook supplements the respective textbook, but it is not a substitution to textbook.

By tradition, the chief function of a work book is evaluation. In a work book, the
same sequential order of the chapters that are in textbook is maintained. So, you get
equal number of chapters as it is in the textbook. In textbook you find exercises at the
end of the chapter. But in a work book, the summary of the chapter will be given in the
beginning. And this will be followed by questions with a provision for student’s
responses. But these questions are not the questions seen in the textbook; they are
more than that. As far as possible, the questions will be distributed over different levels
of learning, namely, knowledge, understanding, application and skills.

 The work book is a readymade book for students’ paper - pencil performance, it
gives an opportunity to organise their learning. Usually, the questions will be objective
based, and vary in types, namely, objective type, short answer type and one or two little
bit long answer type questions. It may take the marks or weightage into consideration,
and frame the questions as one mark, two marks, and four marks questions. Questions
may test the students’ ability to recall, recognition, observation, classification and
identification skills. They may be asked to complete the sentences, diagrams or label
the given figures etc. Under objective type questions, they may vary with multiple
choice types, true or false type, fill up the blanks type, pick out the odd item etc;

With reference to types of work book, one can say that, language work books,
science work books, mathematics and the social science work books are the possibilities.
It is so said because, though the idea of a work book is good, you won’t come across
them much at the high schools that are run by the government. But in recent days, the
state government is also putting its effort in bringing out work books. Certain private
institutions also have initiated their efforts in this direction. As it is already told, NCERT,
a national body produces the textbooks for central syllabus and this will be accompanied
by the workbooks also.

 There is no standardized design for a work book. Therefore they may vary greatly
in content and organisation. For example, at one extreme, workbooks may reprint the
pages of an associated textbooks, replacing key words with blanks that are to be filled
in by pupils after reading their texts. But this type is not considered as a good one. On
the other extreme, work books can give provisions for many different types of activities,
like, forms for reporting data, diagrams to be labeled, blank spaces for ketches and
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clippings, suggestions for supplementary work, study guides for reading assignments,
and self-testing devices. Anyhow, work books are highly individualistic in their approach.
This type of work books, will act as a good record or cumulative record rather, showing
the student’s level of performance unit by unit.

1. As a course of study it shows the pupil where he has been and where he is going;

2. As a study guide it gives him detailed instructions for his work;

3. As a record book it gives him a convenient depository for his findings.

As it is told already, the availability of work book is always under question. So, as
a teacher, it is better if you know how to prepare the work book. If they are available,
then you must be in a position to select the relevant, reliable, valid work book using the
wise knowledge.

How to Select a Work Book?

• It must give an ample scope for students’ drill work and exercises

• It must give the study outlines, adequate worksheets, laboratory directions,
suggestions for all the activities.

• They must be in such a way that, it becomes an easy job for the teachers to evaluate
the students’ performance on a work.

• They must facilitate students’ self-learning more effectively.

• It must be comprehensive, well organised, and free from ambiguity and demand
an active participation by the students.

• The questions on each unit must cater to different instructional objectives, namely,
knowledge, understanding, application and skills.

• It should be consistent with textbook information.

A teacher must not be overwhelmed by the advantages of a work book. While
selecting, he or she must be aware of the limitations of the workbooks also. So, that,
care can be taken so that, as far as possible the limitations in the chosen workbook is
less.

The limitations are as follows:

• Workbooks are relatively inflexible, i.e. the content is highly organised and cannot
be altered easily.
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• There will be little or no provision for the inclusion of new materials. Workbooks
insist on uniform outcomes.

• If the workbooks dominate any educational programme, pupils have little
opportunity to develop special interests and talents.

• It does not give any chance for pupils’ participation during its planning process.

• It does not provide any incentive to independent work, any practice in formulating
their problems and any encouragement to do their own thinking.

Preparation of a Work Book

First identify the objectives, for these instructional objectives will help you. Then
select the content. Let it be divided into simple, sequential, natural, smaller bit of
information. Then pool out different types of question, like, objective type, short answer
type and long answer type. Let it be exclusively a paper - pencil test type. You have to
test the students’ performance at knowledge level, understanding, application and skills
level. Construct the work book with due directions and adequate space for student’s
performance. Remember, each chapter in the textbook will have the respective work
book exercises in the work book.

Usage:

Usually work books are appreciated, because, heavily burdened teachers find the
better workbooks are useful in conserving time and energy, it is because,

• If the workbooks are available means, teachers are free from the preparation of
study outlines, worksheets, and laboratory directions.

• They are also free from devising so many review and drill exercises. That means
to say, soon after the particular lessons and unit is over, simply the work books
could be used for many purposes, including home assignments.

• Workbooks could be used as a standardized record, which will be very easy to
check.

• Workbooks could be used as a very good frame of reference, to know exactly what
to do next and can realize that whether the pupils have been given adequate
directions are not.

• Workbooks can help the pupils working under self direction to study more
effectively.
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• They are also helpful for pupils who have missed time because of illness or from
having left school temporarily due to several reasons.

‘Check Your Progress’-1

1. Audio – Visual Aids are also known as

a) Materials

b) Instructional Aids

c) Machines

d) Teacher’s role

2. Workbook follows the same order as it is in the

a) Teachers’ guide

b) Laboratory manuals

c) Textbook

d) Note book

3. A work book is a……………………....for the textbook

a) Supportive material

b) Supplementary material

c) Complementary material

d) All of the above

4. A work book helps for

a) Teaching

b) Learning

c) Evaluation

d) Keeping the records

5. A work book demands ....................................……..by students

a) Paper- pencil performance

b) Oral answers
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c) Demonstrations

d) Experimentation

26.4 Charts - Meaning, Types, Selections, Preparation and Usage
Charts are visual aids, where the diagrams will have two dimensions, length and

breadth. Hence these are called 2-D aids i.e., two-dimensional aids. Charts are standard
equipments in any subjects, to be used in classrooms. They are the cheap and best,
available teaching aids. They are very advantageous, handy and can be used meaningfully.
They enhance the quality of teaching-learning session. Most of the charts contain diagram
or a series of diagrams. It may contain the portraits of kings, pedigree tree, flowcharts
etc; Science charts usually contain scientific diagrams, where as in case of the subject
mathematics, you can locate graphs, pie-charts, charts showing geometrical figures. In
subjects coming under social sciences, the charts may deal with some important points
written boldly, connected by means of arrows, details of certain dynasty’s chronological
details etc.,

Charts are the devices of one-way communication when certain topics or concepts
are to be taught regularly and they become more meaningful with diagrams. The charts
are more economical, handy and also stimulating. For example, charts such as Periodic
Table, the various systems of common plants and animals are studied in a science or
biology class, the bacteria that cause disease, simple machines, certain flowcharts etc;
are frequently used for several years. Charts could be purchased from companies, or it
could be prepared also. Before knowing about the preparation of charts, let us try to
locate or identify different types of charts.

Types of Charts: You know that, a chart is a combination of pictorial, graphic,
numerical or statistical information which presents a clear visual summary. The most
commonly used types of charts include outline charts, tabular charts, flow charts and
organisation charts. Charts may be of technical diagrams charts and process-diagrams
chart also. Recently, flip charts and flow charts are also being frequently used.

Charts could also be classified in terms of arrangements and the kinds of ideas
that they express. In this type of classification, there are five major types, each type has
further classification. Now, let us take up then one by one to understand clearly. The
five types of charts are,

1) The narrative charts 2) The tabulation chart 3) The cause and effect chart 4) The
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chain chart and 5) The evolution chart

The narrative chart: These charts include the facts and ideas arranged and expressed
from left -to - right. For example

1. The events in a process, such as, soap making, plastination etc;

2. The information with reference to parliamentary activities, Election        Procedure
etc;

3. The information with reference to technological improvement over a period of
time, like, developments in the field of computers and ITs improvement in
transportation, communication etc;

The Tabulation chart: It is a chart showing a left-to-right, top-to-bottom arrangements
of facts and ideas for expression. For example

1. Numerical data for making comparisons

2. Lists of products, rivers, schools in a particular area, examination centres etc;

The cause and effect chart: These include inter-related facts and information presented
from left-to - right.

For example:

1. Relationship between entry behaviours and instructional objectives and evaluation.

2. Relationship between standard of living and, availability of natural resources,
economic system, technological advancement etc;

3. Relationship between rights and responsibilities.

4. The Chain chart: These include a circular or a semicircular arrangement of facts
and ideas. For example:

1. A pi-chart showing details of literates, illiterates, among men and women population.

2. Natural cycles, like, water cycle, oxygen cycle etc;

The Evolution chart: Includes a left-to-right arrangement of facts and ideas for
expressions. For example:

1. Evolution of man

2. Evolution of life on earth etc;

Graphs: Graphs are flat pictures which employ, clots, lines or pictures to visualise
numerical and statistical data. Graphs are of several types, namely, line graph, bar
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graph and circle graph etc;

Line Graph: Here the data is represented with the help of simple lines horizontally or
vertically drawn.

Bar Graph: A bar graph consists of bars arranged, horizontally or vertically from a
‘Zero’ base. The colour, length and size of the bats represent different variables
and values.

Circle Graph: It is also known as Pi- Graph. Here the data is represented in a circle; it
may make use of different colours to represent different variables.

Selection of Charts: Charts however may be good but cannot replace a teacher. Only
thing is, charts are used to enhance the quality of teaching-learning process. Charts
are advantageous, but they are not free from limitations. So, while selecting the
charts, a teacher must choose the charts which have less limitation. So, how to
select a chart? Let its see the following points.

1. Charts should always be large for general class use.

2. All lines should be distinct and the printing should be readable from all parts of
the classroom.

3. Charts must have employed proper, colour background, bold letters with contrast
color so that it will be eye catching.

4. Too much colourful charts will be a negative point, it leads’ to eye strain and
confusion. Non-functional colour applied for decorative effects, should be avoided.

5. Each chart should be simple and uncluttered with adequate space between
separate items.

6. They should contain only the essential details, with proper headings and
footings, and correctly labeled diagrams.

7. A chart should be self explanatory with better clarity.

8. A chart should not contain too many details.

9. The teacher should make sure that there is a provision for hanging the chart

10. A proper care must be given in conserving and preserving the charts.

Preparation of Charts: Sometimes teachers feel that, to get a relevant chart for a
particular concept is highly difficult. It is because, all types of charts to suit all types of
concepts. Then comes the need for the preparation of charts. Anyhow, chart making is
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an excellent project for pupils! They may do it, carry out either as a service to the
teacher or as part of presentations which they themselves plan to make.

For temporary use, charts may be made by using a sketch pen on large sheets of
wrapping paper or drawing sheets. But these charts are not very durable and are easily
damaged during storage.

Permanent charts are made on special chart cloth. Outlines are drawn in pencil
traced in India Ink with a ball - tipped pen, a drafting pen, or sketch pen. Coloured
lines, labels and arrows may be added with coloured drawing inks. Coloured areas may
be filled in with wax crayons, after which the wax is blended in by applying a warm
iron to the reverse side.

An opaque projector is of great help in laying out a chart. The chart cloth is tacked
to a bulletin board in a darkened room. A diagram from a book or a clipping is put in
the projector and focused on the cloth. By moving the projector to and fro, the size of
the image can be varied until it fills the desired space. The outlines are traced in pencil
and can be inked later.

Usage of Charts:

Charts could be used for the following purposes:

• To show relationship by means of facts, figures and statistics for a good explanation
with clarity

• To summarize the information

• To give the concrete ideas for certain abstract concepts while teaching to motivate
the students

• To develop, sustain and maintain interest throughout the teaching-learning session
as a stimulus variation.

• Charts are the cheap and best attention compellers; hence a teacher should use
them as support materials while teaching.

• A teacher must use the relevant charts with due consideration to the medium of
instruction. For example, while teaching in a Bengali medium class, the charts
with English labeling must not be used and vice-versa, is also must not.

‘Check Your Progress’-2

1. Charts are ……….. aids

a) Audio b) Audio-visual c) Visual d) Projected
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2. Charts do ……... communication

a) One-way b) Two-way c) No d) Both a & b

3. Charts are used to give clarity for

a) Concrete ideas b) abstract ideas c) easy ideas d) visual ideas

4. Mention the different types of chart

5. List out any four criteria for the selection of a chart

6. Mention any two uses of charts

26.5 Models - Meaning, Types, Selection, Preparation and Usage
Models are substitutes of real things and it is a three-dimensional representation

of the real thing. Hence they will be concrete in appearance. Through its concrete
appearance, a model helps in clear understanding of structure or functions of a real
thing. It is also said that, a model is the replica of original things. It is the miniature of
the original one, for gigantic original things. Practically to take all the students near a
big industry, or any historical monument (Say Taj Mahal) is impossible. In such situations,
models will fulfill the learner’s need.

Models of specimens, steam engines, gasoline engines, a cross section of a leaf,
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and the parts of al flower, an atom etc; are the replicas of the original ones. They will be
exactly similar to the real objects except for size.
Sometimes, it so happens that, models are considerably larger than the real objects (for

example, model of a human eye) and sometimes they will be small replicas of
objects which are too large to be seen as a whole, (for example, model of an
Airplane). In many cases working models of the original are used where the specific
action of the original is duplicated and could be explained easily. In such cased,
models have proved that, they are more effective than the reality.

Types of Models: Models fall into different classification. Basically, there are two
types, namely working models and still (static) models. They can be classified as scale
models, diagrammatic models, display models and operating models also.

a) Working models and static models

b) Scale models: enlarged and reduced scale models

c) Diagrammatic models: emphasizing selected features and suppressing others for the
sake of clarity.

d) Operating models: Show the action of moving parts.

Selection of Models: A teacher has to select the models based certain criteria. For
example, first of all a model must be of adequate size to be seen clearly from all parts
of a room.

• For individualized works, you better go for smaller models.

• A model must be three dimensional, excepting certain cross sectional models.

• The value of a model lies in its presentation of the parts in their proper spatial
relationships.

• One of the very important criteria is, the degree to which a model resembles the
real object, that too, to what extent

• Models should not be over simplified

• You should consider in priority, the subject to be taught, model to be used and age
level as well as maturity level of the learners.

• A model should not be made of fragile material.

• A working model will secure immediate attention and will serve as motivation.
Thus, interest stimulated could be utilized to fullest advantage.
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• Models should be used only if it is not possible to get real objects to the
class room or when the real objects would not be helpful to give a better
explanation.

Preparation of Models: Preparation of models could from a topic for project work.
This activity will really fascinate the students. For this a teacher has to provide an
opportunity as well as suitable guidance to them. Ask them to prepare a simple paper
or clay or plastinated models in the beginning then, later to prepare the sophisticated
working models. Model making, gives a very rich learning experience to the students.
Models which can be dissembled and assembled by pupils have enormous learning
value.

Materials for Preparation of Models: Models could be made up of plaster of
paris, wood, metal, or cardboard and plastic also. So, depending upon this, the list of
materials required will vary. Therefore, let us make a list of the respective requirements.

Cardboard Models: Cardboard of suitable thickness can easily be cut, desired
shape could be formed, pasted and given a better look by coloured paper.

Plastic Models: Clay, bees wax and plasticence (available in several colours) could
be moulded easily to desired shape and models prepared.

Easily Workable Materials: Thermocole could be easily cut with hot wire, bound
together with fevicol, finished with sand paper and coloured with water colours using
brush.

Plaster of Paris: Duplicate copies of objects with plaster of paris could be made
easily.

Wood: Models could be made with wood -hardwood, light wood and easily workable
also wood.

Metal: Most working models require metal - in the form of sheets, rods, tubes,
angles, wires etc; and of course necessary tools for fabrication are required.

Thermocole Models: Thermocole is available in half sq. mt. sheets. Thermocole
could be easily cut with a knife or an electrically heated wire. A surface finish could be
affected using sand paper.

Modeling clay has several uses in the biological sciences. Plaster of Paris is a
versatile material. It gives sharp castings; it may be drilled, sawed and sanded; it may
be tinted and painted. It may be used for casting animal tracks found in mud.

Use of Models: Models are three dimensional; hence they give more clarity during
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explanation when compared to charts. Following are some of purposes in which models
serve as the best devices.
• Models evoke greater interest and help in enhancing the learning.
• Models concretise abstract concepts. They simplify complex objects and accentuate

important features with colour and texture.
• Models are handy, and are of compact dimensions so that they can be used in the

class room teaching. It is possible to reduce or enlarge the objects to an observable
size.

• Practically, it is not possible to see the whole of a large industrial unit or even a
large machine unit, but if a small scale model is used, it gives the correct concept
for the students.

• A large process could be easily demonstrated by a model as it provides interior
views of objects and machines.

‘Check Your Progress’-3

1. Models are …………… devices

a) Uni - dimensional

b) Two-dimensional

c) Three - dimensional

d) Four-dimensional

2. Basically models are of two types, namely, Static models and

a) Working models

b) Three dimensional

c) Still models

d) None of the above

3. Models ………….abstract concepts

a) Complicate

b) Concretise

c) Duplicate

d) None of the above
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4. State whether the following statements are true or false

a)  Models evoke interest and enhance effective learning.

b)  Models are too large to be carried out

c)   It is possible to reduce or enlarge the objects to an observable size.

d)  Models should not be made of fragile material

e)  The value of a model lies in its presentation of the parts in their proper
combination.

5. Mention the types of models.

6. Write any two criteria for the selection of a model.

26.6 Specimens - Meaning, Types, Selection, Preparation, Usage
Certain subjects are more problematic while teaching, so that, unless and until,

some of the live examples are provided, the concepts cannot be understood properly.
Biology is one among such subjects. Most of the time, it includes the study of weeds,
insects, rodents, birds, fur-bearing animals, trees, shrubs, plant and animal diseases.
When a teacher realized that, there is-a need to preserve certain organisms for multiple
times of usage while teaching, then the need of a special technique in preserving them
as live or dead, also arose. In such situations, an enthusiastic life science teacher, goes
for collection of live organisms which could be utilised for illustrations during
explanation. For example while explaining the concept of “adaptations in xerophytes”,
a cactus plant is used. Similarly while explaining external features of birds or fish in
general, live animals could be used. Isn’t it? The use of live organisms for illustrations
is called specimens.
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What is a Specimen?

A specimen is an individual or part of an organism (plant or animal) taken as an
example to illustrate the teaching points. Usually the live organisms are preferred. But
this is not possible for all the times for all types of illustrations. In such cases dead
plants and animals either as a whole or part which are preserved scientifically are used.
These types of specimens are called preserved specimens. Now let us try to understand
what are the different types of specimens and where are they used, and also a few
procedures of preserving specimens.

Specimens are very special type of instructional aids that are made up of dead or
alive individual part of plants and animals maintained and preserved scientifically.
These are real objects and hence give three - dimensional effect, and concretise the
abstract concepts. Because of this the learning process becomes easier and smooth
going.

Types of Specimens:

Specimens are basically of two types, namely microscopic and macroscopic.
Microscopic specimens are so small that they cannot be seen by naked eye for examples
Algae, Volvox, Protozoa, Bacteria etc. Macroscopic specimens are big enough to be
seen by naked eye. For microscopic specimens a compound microscope must be used
for observation. In both microscopic and macroscopic specimens, we come across,
live and dead organisms. They could be plants, animals and micro - organisms. Specimens
are also of bottle specimens type. Here usually, the dead plants and animals either as a
whole or a part of it are preserved in the medium of formalin solution. Such specimens
are called Bottle Specimens.

Sometimes, the organisms, after killing are dried and preserved. Such specimens
are known as Dry-specimens. In case of plants, certain parts like, fruits, inflorescence,
special type of leaves or modified parts are preserved. In case of animals, usually,
molluscs and echinoderms are preserved as dry specimens. Invertebrate animals, their
hard bones are preserved as dry-specimens. In case of plants, herbarium preservation is
employed. It is also an example for dry -specimens.

Selection of Specimens:

• Whenever the live, specimens are available preferably these have to be selected.
But it has to be checked with facts, like, ease of handing them, dangers involved
while handling etc;
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• As far as possible select the specimens of such type, where children can learn by
seeing it clearly, touching it and feeling it.

• If possible go for multiple number of specimens, so that, it becomes possible for
you to give individualized instruction.

• While selecting the specimens, it is advised to follow a hierarchy, like, live
specimens first and preserved specimens second. In preserved specimens, it can
be formalin preservation, dry preservation and herbaria.

• Specimens are the best supporting materials, provided they are selected with proper
relevance with subject matter to be taught.

• As far as possible, select the relevant specimens which are available abundantly in
their natural habitat. Then, you can involve all the students very actively in
identifying, locating, classifying, observing, comparing and also preserving the
specimens in their natural habitat.

Preparation of Specimens: There are several methods of collecting, culturing
and preserving which are quite useful and may be known to you. Here are some selected
procedures which are intended to be suggestive rather than comprehensive.

A. Preserving specimens in wax:

Materials Required: Coffee can, sealing wax, newspaper, pair of pliers
and leaf specimens.

Procedure: Melt some wax in a coffee can. Group the petiole with pliers. Dip the
leaf in melted wax and remove quickly to allow the wax to cool and harden. Colourful
leaves can be preserved in this way so that they will retain colour also.

B. Alizarine Preparation: (Embryo and small animals like fish)

Materials Required: Alizarine red, alcohol, glycerine, specimen jar and KOH.
Alizarine gives stain to the bones and makes the body tissue transparent.

Procedure: Keep the embryo in 70% to 80% of alcohol and small animals i.e.
fish, small lizards etc; in 90% alcohol for 24 hours. If the dehydration is not proper, it
can be kept for 36 hours. Then change in 1 % solution of KOH, to be changed every
day in the same concentration but with fresh solution till the muscles become transparent
and bones are visible. This generally takes four to seven days depending upon the
nature of the muscles in a particular animal. Now transfer the animal in Alizarine Red
prepared in 90% alcohol or 4% Alizarine in 90%. Watch it carefully. If over-stained,
wash it in pure glycerin. It can then be finally mounted under glycerin.
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C. Preparation of Green Algae and Fungi Specimens:

Take about 90 cc of 50% alcohol. Add to it 5cc of pure formalin (commercial
formalin which is 40%). Shake the bottle properly, and then add 2.5cc pure glycerin +
2.5 cc, glacial acetic acid. Lastly, add to it 1/2 gms of copper chloride. In this solution
the common algae can be kept for a number of years.

Or

For green algae only place the material in solution of 1% copper acetate + 2%
formalin for 24 hours. Then preserve in 5% formalin.

Fungi: Take 25 gms of Zinc Sulphate and 1000 cc of water. Add to it 10 cc of 5%
formalin. Preserve the fungus in it. It will maintain original colour of fungus.

D. Preparation of some animal specimens:

I. Sponges: Collect the sponges from their aquatic habitat (most of them are marine,
only a few are available in ponds, lakes and streams). They may be seen on sticks,
stones and other objects submerged in the water, as soft white or brownish slimy blotches
varying an inch or little bit more than an inch in diameter. Fresh water sponges could
be preserved in a balanced aquarium. Other sponges can be dried and mounted in
boxes. They can also be preserved in 5% formalin or 70% alcohol.

II. Worms: Planaria found in fresh water, and other parasitic forms of worms,
namely, liver fluke, tape worm, round worms.etc., can be got from their respective
habitat or host, such as birds, fishes, rats, dogs, cats etc;

Planaria could be collected by scrapping off from the submerged objects. Place
one or more worms near the middle of a slide and cover them with a second slide. Put
enough pressure upon the upper glass to flatten the worms, but be careful so, that they
are not crushed. Place these slides in a shallow dish or pan and pour over them a
solution of 5% formalin. Slightly tilt the slides, so that, the preservative will spread
uniformly and fix the worms. Allow it to be submerged for a period of two hours or
more.

III. Fishes: Collect the fishes from their respective habitat. If the animal is bulky,
puncture it at places so that the preservative enter the animal body. Add 15% glycerin
to the preservative, so that it avoids the animal body becoming stiff.

IV Birds: Birds can be preserved in 7% of formalin solution or they may be skinned
off and stuffed.
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Usage of Specimens

Specimens could be alive or dead and preserved. They could be microscopic as
well as macroscopic. Both types are highly advantageous for a teaching learning session.
Let us list the occasions where such specimens are used to bring about efficient and
effective teaching.

• Live specimens, give the chance for the observation of the external features,
locomotion, type of its adaptations to the environment

• Students can gain first hand information through specimens.

• Certain rare or endangered species could be well studied through the preserved
specimens.

• Preparation of dry - specimens, like sponges or herbarium sheets, gives ample
scope for students’ active participation and whole hearted involvement.

• Specimens help in concretising the morphological as well as anatomical features
of organisms.

• Encouraging students to prepare the specimens can inculcate disciplinary values
among the students.

‘Check Your Progress’-4

1. Specimens are usually made up of a sample or a part of or the whole of …..

a) Plants and animals b) materials c) Machines d) Non-living things.

2. Specimens preserved in formalin are called

a) Dry - specimens b) Stuffed specimens c) Bottle specimens d) Herbaria

3. Herbaria are prepared by using

a) Parts of an animal

b) Twigs of plants /whole plants (if they are small)

c) Glass slides and formalin solution

d) Parts of fossils

4. Write any two uses of specimens

5. Mention any two criteria for selection of specimens.
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26.7 Maps and Globes - Meaning, Types, Selection, Preparation
and Usage

Generally maps and globes are used both in Science and Social Science subjects.
They are indispensable aid in teaching many subjects particularly, Geography, History
and Economics. They are defined as “the graphic visual representations of the earth’s
surface, or position of it. Maps may cover different themes as well as locations. They
are constructed based on the information borrowed from various sources. However,
map writing is a special skill which needs proper and adequate training and practice. A
map will be accurate representation on plain surface in the form of a diagram drawn to
scale, as, the details of boundaries of continent countries, etc. Geographical details like
location of mountains, rivers, altitude of a place, contours of the earth surface and
important locations can also be represented accurately with reference to a convenient
scale with suitable colour scheme.

There are several points or aspects that make a map reading more meaningful.
They may be listed as follows:
• Understanding and interpreting the key of index.

• Understanding the lines - i. e boundary lines, lines of communication, lines
indicating the rivers, contours, meridians and parallels.

• Understanding the colours, tints, shadows and symbols in a map or a globe.

• The top of every map is not north, but the direction of northern pole is north.

• Distinction between the various types of maps, such as relief, political, distribution
maps etc;

• For a better map understanding, the position of the earth in the universe has to be
understood first. Many students suffer from a notion that the earth leans in June
towards the Sun northwards and in December southwards and thus the seasons are
formed. But, you know, earth never dances that way! It is because, the inclination
of the earth is constant, and the seasons are formed due to its rotation around the
Sun.

Globe: Globe is a spherical model of the earth. A good globe should provide
correct information about areas, distances, directions and geographical shapes. Even
the best flat map cannot achieve accuracy comparable to that of a good globe, as a flat
representation of any segment of a spherical surface involves certain unavoidable
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inaccuracies. The language of maps and globes is largely a language of colours and
symbols, standing for locations, boundaries, rivers, routes and other features. Colour
helps in legibility as well as beauty in maps and globes. Some symbols on a map look
like the things that they are supposed to represent (like international road signs) while
others are rather arbitrary and pupils should be trained to interpret them.

Before pupils understand maps, they should understand globes. Globes are of three
types, namely:

Political Globes: which show the location, boundaries and place details of different
countries;

Physical - Political globes: In addition to the above they also show physical features.

Slated Outline Globes: On which teachers and pupils can write using crayon or
chalk.   This is very useful for direct pupil activity.

Globes come in different diameter sizes; the 12" and 16" being the most commonly
used. The larger sized globes have the advantage of readability. Globes differ in the
level of information presented, depending upon the educational level for which they
are intended. Globes are available suitably mounted with latitude scales, and free floating
globes which could be taken out are also available.

Knowledge of map and the knowledge of globe - are reciprocal to each other. In
fact, globe is considered as the true map. It is the true representative of the earth’s
physical personality. A globe gives a true idea of total environment at a glance in a
classroom situation. It helps the students to understand more effectively, the abstract
concepts, like, time, space, wind’s planetary relations and proportions. Hence, every
school should have globes. The following four types of globes may be kept in every
school.

1) Political Globes

2) Physical Globes

3) Washable projection globes

4) Celestial globes.

Types of Maps: Maps are prepared on different themes. So, let us see some of the
varieties of maps.

Relief Maps: (Regional and the world): This requires the knowledge of colours,
symbols and other connected ethics of map making.

Historical Maps: This type of maps reveal the changing times and the growth
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and decline of various kingdoms. To construct such maps, knowledge of lines of
boundaries and other symbols is necessary.

Distribution maps: There are several types of distribution maps. For example,

a) Vegetation maps

b) Population maps

c) Economic maps

d) Statistical maps

e) Dot maps

f) Pictorial maps

g) Language, race and other human division maps, etc.,

Geographical maps: Contour maps, weather maps, seismological maps,
archeological maps, rainfall maps, geological maps etc; are grouped as geographical
maps.

Selection of Maps and Globes: Maps and Globes are known for their one-way
communication. Hence they have to be self-explanatory while selecting the maps and
globes a teacher should employ certain criteria, and they could be mentioned as follows:

• A map must be large enough so that, every detail depicted should be visible to
every pupil in the class wherever he is sitting.

• It should not deal with too minute details or too much written matter. Whatever
the key index are used, they have to be interpreted.

• A map should have clear boundary lines, lines of communication, lines indicating
the rivers, contours, meridians and parallels.

• The direction, namely, north, south, east and west must be indicated very clearly.

• Maps and Globes must have a professional appearance by means of coloured
papers, charting tapes and adhesive letters.

• Maps and Globes must be in such a way that, if they are used, they should
create a suitable environment in the classroom.

• Each map should deal with the specific concepts, focused exclusively.

Preparation of Maps and Globes:

Globes with different sizes and with different information are available in certain
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educational equipment dealers. They could be purchased from there. And some of
them could be prepared by the teacher as well as from a group of students. Making
maps and globes can become individual student projects. Some concepts in the social
science subjects, like world map, map of Asia, distribution of vegetation etc; will be
challenging as well as channelizing the students energy. A map should have proper
headings as well as footings with bold and contrast colours. One thing must be kept in
mind very clearly that, these instructional aids should be self-explanatory.

Materials required for the preparation of maps:

1. White drawing paper-white cartridge paper.

2. Black cartridge paper

3. Coloured cardboard

4. Pencil - drawing H, 2H, HB

5. Water colour tubes

6. Poster colours

7. Hair brushes nos. 1- 6, flat brushes 1.5 cms, 2 cms.

8. Water proof drawing ink assorted colours _

9. Ruling pen, funnel pen

10. Script pen nibs - holder

11. Poster paper - assorted colour

12. Adhesive paste - gum

13. Felt pen - felt maker- assorted colours

14. Nylon fiber tip pens - assorted colours

15. Inks - different colours for felt and nylon tip pens.

16. Self adhesive tape - PVC - assorted colours 1, wire for edge binding.

17. Letter and number stencils

18. Stencil cutter - holder

19. Gauze cloth - (for backing)

20. Wooden reapers. 1/2”  x 1" cross - section - any light wood.
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The visuals to be depicted are to be pre - planned. A rough sketch may be drawn or
a suitable book of diagrams could be selected. Textbooks, reference books, encyclopedias,
journals, catalogues, etc., may serve as resource materials for preparation of maps.

Projection tracing is an easy way to make a large chart map from a small illustration.
A small picture can be enlarged by using an opaque projector. The small book illustration
can be placed on the projector and a cardboard can be attached to the wall. The size of
projected picture may be adjusted to fit the required area by moving the projector closer
to the cardboard (to make it smaller) or farther away from the cardboard (to make it
larger) and focusing as necessary. The main lines of the projector picture may be traced
with pencil. After completing the drawing, ink in the lines using pen or felt pen. This is
one of the easiest and quickest ways to enlarge a picture.

The overhead projector can be used if a transparency or a slide of the original
diagram is available. A photograph also may be used to enlarge or reduce pictures. By
using the squaring method, a picture can be proportionally enlarged or reduced or even
elongated and distorted purposefully. The lines drawn should be bold and of uniform
thickness throughout. Felt marker will be highly suitable. Larger areas can be coloured
uniformly by pasting suitable colour, poster paper over which shading could be done
using felt pen, nylon tip pen or water colour etc.,

Uses of Maps and Globes:

Maps and globes have innumerable practical value. So, now let us list few of them.

• They are essential to understand the whole range of human activities, such as
interpreting weather, travel, understanding current world events, etc ;

• They are essential for a full understanding of the world, its people and the space
around us.

• Map reading skills have to be developed in pupils so that they are able to readily
interpret the information contained on maps.

• Maps enable us to see the complete world at one time; Globes reveal half of the
portion of earth at a time.

• Effective use of maps and globes is based on map reacting readiness, for this
extensive observation of the local environment and early experience with globes
and global concepts, have to be planned and opportunities must be given to the
students.

• Pictures and films are to be used to give greater meaning and usual imagery to the



357

features and symbols used in globes. Systematic instruction in geographical concepts
enabling pupils to read and interpret globes and maps should begin at the middle
school levels as an integral part of the geography, and history lessons.

‘Check Your Progress’ - 5

1. Globe is a ……………

a) Round device b) Earth

c) Spherical model of earth d) Sphere

2. A map is said to be …………..

a) An instructional aid

b) A two dimensional aid

c) Self explanatory aid

d) The graphic - visual representations of the earth.

3.   The language of maps and globes is

a) The language of colours and symbols

b) English language

c) Regional language

(d) None of the above.

4. Mention any three geographical maps.

5. Name any three distribution maps.
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26.8   Let Us Sum Up
In this Unit, the instructional aids other than textbook have been discussed. These

are also known as support systems. They make the teaching - learning situations more
effective and efficient. Details with respect to work-book, charts, models, specimens,
maps and globes - have been narrated.

In all these cases, the respective, meaning, types, selection, preparation and usage
have been explained. Among them, some are two-dimensional and some are three
dimensional aids. But all of them are visual aids. A work-book in most of the time is
used as a formative evaluation device. And it tests the intellectual or cognitive abilities
that are developed after the teaching of a unit. Whereas charts, models, specimens,
maps and globes enhance the quality of learning among the students. Each one of such
instructional aids has its own criteria to get selected. A teacher, therefore, has to select
the instructional aids very deliberately. Preparation of charts, models, specimens and
maps can become a very good and interesting project work for the students. Usually
preparation and use of specimens confines to the subjects under natural science. In all
these cases, one thing is very clear, that, if these instructional aids are well prepared
with good quality materials and preserved properly, then they can be used for several
years.

26.9 Answers to ‘Check Your Progress’
‘Check Your Progress’- 1

1. b) Instructional aids

2. c) Textbook

3. d) All the above

4. c) Evaluation

5. a) Paper-pencil performance

‘Check Your Progress’- 2

1. c) Visual aids

2. a) One-way communication

3. a) Concrete ideas
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4. The different types of charts are,

a. The narrative charts

b. The tabulation chart

c. The cause and effect charts

d. The chain charts

e. The Evolution chart

f. Graphs.

5. Write any four criteria from selection of charts in section 26.4

6. Write any two uses of charts from usage of charts in section 26.4

‘Check Your Progress’- 3

1. c) Three - dimensional

2. a) Working models

3. b) Concretise

4. a. True

b. False

c. True

d. True

e. True

5. The two types of models are,

i) Working models and ii) Static models

6. Write any two criteria from selection of Models in Section 26.5

‘Check Your Progress’- 4

1. a) Plants and animals

2. c) Bottle specimens

3. b) Twigs of plants / whole plants (if they are small)

4. Write any two uses of specimens from usage of specimens in section 26.6
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5. Write any two criteria for selection of specimens from selection of specimens in
section 26.6.

‘Check Your Progress’- 5

1. c) Spherical model of the earth
2. d) The graphic visual representatives of the earth.
3. a) The language of colours and symbols
4. Mention any three geographical maps from types of maps in section 26.7
5. Write any three distribution maps from types of maps in section 26.7

26.10   Unit-End Exercises
1. What is a work-book? Explain its nature in detail
2. What are the characteristic features of a good chart?
3. How models are selected? What is the basis for their selection?
4. Explain any two procedures for the preparation of specimens of your choice.
5. What are maps and globes? Where are they used?
6. What are the general principles for selection of any instructional aid?
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27.1  Introduction
In the previous Units you have come across several instructional aids. Sometimes

they are purchased and sometimes they are prepared. Though due importance is given
towards the durability or the longevity, after a few years, the instructional aids get
distracted; may become broken. At this situation, it is easy to discard but we need to
think and ask “Can anything be done to this equipment?” “So that, it get repaired or
improved and becomes fit enough for re-use?” This is where the concept of
“improvisation of aids” gets originated. So, in this particular unit, we shall focus on,
meaning, importance and need for improvising the learning aids. You will get a list of
merits and demerits of such apparatus. Inspiring illustrations also will be there.

Sometimes, teachers feel it is highly difficult to teach certain concepts without the
support systems i.e. instructional aids. Especially in a subject like Science, several
experiments have to be carried out, students must get training in scientific method,
scientific attitude should be inculcated - all these are expected. Isn’t it? For this, a well
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equipped, sophisticated laboratory is needed. But in a developing country like India,
all high schools with such a set up is so far from the reality. In this circumstance we
cannot wait for that day, when the government will provide all facilities for teaching
Science, and other allied subjects. As a solution to this problem, “improvisation of
apparatus” - concept is generated. Its essence lies in the principle what is known as
“Low-cost and No-cost materials” in which many learning aids are prepared by simple
articles found in homes and other places. The only thing required is the ingenuity and
resourcefulness of the teacher and his willingness to work. So, let us devote some of
our time, to understand this concept and try to inculcate this value based skill into our
personality with an honest effort.

27.2   Objectives
After studying this Unit you will be able to:

• Explain the meaning of “Improvised Learning Aids”

• Justify the need for developing skills in preparing Improvised Learning Aids

• List out the merits and demerits of Improvised Aids

27.3 Improvised Aids
By going through the introduction part this unit, you should not come to a conclusion

that such an effort is confined to Science only. Even the subjects under Social Science
category, give an ample scope for improving the apparatus and equipment. See, the
principle here is “Nothing is waste; and a waste is not a waste”! As far as possible,
think about the re-usage, re-cycling of the materials. This holds good irrespective of
any subjects. Take for example, in the Geography, a globe, with faded colours and lines
invites you to improvise it. Similarly, it could be an old periodic table, or a physical
balance prepared by using the cheapest materials!

2 7.3.1 Concept

When a school budget does not permit the purchase of learning aids and other
scientific equipments, to be used for instructional purposes, then the teacher may wish
to solicit the aid of other faculty members and the students as well, in creating such
equipment. For example;
• Calorimeters can be improvised with the help of several “tin” cans
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• Christmas tree electric lights and wiring can be employed in teaching Series and
Parallel circuits.

• Principles of light can be taught with the help of ordinary face mirrors found in the
home.

While perforning such activities, students’ complete involvement will be a boon.
Because they will be glad to bring simple machines from home, like, nutcrackers, screws,
hammers and other tools. All the above said examples imply that, an improvised aid is
not the new one, purchased from the market, but a self prepared or repaired apparatus.
And for such a preparation, the expenditure will be completely nil or very low. Most of
the time, the thrown out materials and un-wanted waste materials are collected and get
a touch of re-cycling process or repair, so that they could be re-used.

Such improvised aids have their own characteristic features. It becomes in priority,
that one should know such special characteristic features, before jumping into their
preparation. Hence, now, let us list out the characteristic features of low-cost educational
materials or what is known as Improvised Aids.

i) They are made up of some of the raw materials that are available either free or at
low cost in the local environment.

ii) The materials do not involve specialized skills and can be made by pupils, teachers
or members of the community.

iii) The materials will be fit enough, so that they can be easily and effectively used by
the teachers and pupils in clarifying the set objectives.

iv) The process involved in the production of the materials is simple and inexpensive.

v) The material is simple, accurate, and appropriate to the age level of the users.

vi) The material stimulates thinking, reacting, and discussing, experimenting or further
study.

vii) The material is free from distractions, conflicts or bias.

viii) The production of the materials is not time-consuming.

All the above mentioned characteristic features, make it very clear that, improvising
equipment will lead to an application or translation of a scientific idea. In such cases,
talented, creative students are identified. Hence, some of the equipment construction
activities by pupils should be encouraged even if there is sufficient budget to purchase
many of the required laboratory supplies. For example, in teaching life sciences, the
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teacher can use initiative and resourcefulness in creating some basic equipment, like a
micro-projector can be assembled from one microscope and an ordinary slide projector
which is used as a source of light. By tilting the microscope so that the viewing cylinder
or barrel is parallel with the surface of the table, the image can be projected on a screen
placed in front of the ocular. It is necessary that the mirrors and light box be removed
and that the source of light (slide projector) be directed close to the stage of the
microscope to permit the light to enter the objective and leave through the eye-piece on
the screen. The size of the projected image on the screen can be controlled by varying
the distance between the screen and the eyepiece of the microscope.

27.3.2 Importance

Improvising the learning aids is a challenging job both for the teacher as well as
the pupils. A success in such activities always will be thrilling experience! No doubt in
it. Hence such activities become very significant in a school life. So, let us now list out
certain points which reveal the fact of importance of the activity of improvising
instructional aids

• It brings a common forum for the teacher and the students to get involved completely
with a constructive approach.

• It encourages the team spirit, and many talents among the students flourish, which
otherwise would not have been expressed at all.

• As it is, there is a greater lacuna in providing the infrastructures and the learning
aids to the schools. Especially in few subjects, there will be a serious dearth as far
as learning aids are concerned. In these circumstances, the quality of teaching and
learning will get affected. Hence construction of learning aids or improvising the
instructional aids becomes very important.

• It is a fertile area for the all-round development of a student’s personality, if used
properly. It brings a coordinated development of cognitive, affective and psycho-
motor domains of a student’s personality. Because, students use their ideas
(cognitive), do the work with utmost zeal and interest (affective) and honestly,
industriously perform it. (psychomotor)

Apart from these, you may find some more relevant aspects that reveal more about
the importance of improvised aids; so go ahead and enrich the concept.



365

27.3.3 Need

The concepts, namely, the importance of improvised aids and the need for
improvised aids may apparently look overlapping. But there is a subtle difference also!
So, in this caption we shall concentrate the same concept from a different angle, ie.
need for improvised aids.

To understand this concept, we should take a swift look at the economic status of
our schools. It is really pathetic. There are many schools even without the basic
facilities, then what about the case of instructional aids? You may be surprised, to
know that, there are certain schools even without a single instructional aid also.
Before teaching any concept, the objectives are framed first. These objectives
may spread over the cognitive domain, affective domain and psychomotor domain.
In order to achieve such objectives, mere oral explanation definitely will not suffice.
If the learning aids are already available, it will be OK! Imagine, no instructional
aids are there, then, there arises a need either to prepare low -cost instructional
aids or to improvise them.
There might be some artistic values hidden in the students’ personality. As it is,
the fixed schedule of the time-table may not give a chance to nurture the student’s
hidden talent. But this has to be taken care of with some priorities. For this
improvisation of aids is the best platform.

A Few Illustrations for Improvised Aids

Biology, there is ample scope for improvising aids. Let us have a look at the
following examples:

Animal cages, terraria, aquaria, herbaria, and flower boxes, that provide adequate
use for many interesting species of plants and animals.

A living laboratory consisting of frogs, birds, fruit flies (Drosophila melanogaster),
earthworms, snails and fish can provide students with worthwhile experiences in the
care and feeding of animals. Here biological principles can be taught effectively through
the use of living as well as preserved specimens.

The above said activity, needs some simple materials like, mesh wire from the
hardware store, sheet metal or tin plates, coffee cans, discarded glass jars and bowls,
plate glass, and a few wooden crates are the basic materials for making homes for
representative plant and animal life.
• Museum jars for display and study purposes are invaluable as teaching aids in

biology. Empty pickle, fruit, coffee containers and large jars can serve as museum
jars to house preserved biological specimens.
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• Many insects can be preserved in glass jars that are filled with 70% alcohol.

• Aquatic snails, clams, fish, small mammals, can be preserved in jars containing
8% formalin. Worms and frogs can be preserved in 5% solution of formalin.

• An ordinary ink - pot can be improvised as a spirit lamp.

Voltameter: Take a plastic glass and pierce two holes at its bottom. Insert two
copper wires one in each hole. Fill the glass with acidulated water and invert two test-
tubes of water one on each wire. On connecting the wires to the two term of a battery,
water will begin to decompose into Hydrogen and oxygen which get collected in the
two test tubes. This is known as Voltameter.

Astronomical Telescope: Take two cardboard tubes one fitting in the other. Fix
two lenses of different focal lengths at the end of each tube. The lens of low focal
length of around 2 cm or 3 cm serves as the eye piece and of 15-30 cm as the object
lens.

A simple syringe pump: Take a broken glass or metal tube and close its one end
with a cork carrying a glass tube. A small metal rod and a cork wrapped with rag will
serve as a piston.

Electromagnet (horse-shoe): Obtain a U-shaped piece of iron about 5 mm in
diameter. Wind a coil of several layers of bell wire on each arm of the magnet leaving
the curving part. Begin at the end of one arm leave about 30 cm of wire sticking out for
connections. Wind about three layers on this pole, then carry the wire across the top to
the other end; be sure to wind this pole exactly as shown in the diagram. Connect the
open ends of the wire to a battery and test for polarity with a magnetic needle. One end
should be north pole and the other south pole. If both ends have the same polarity, you
have wound the second coil in the wrong direction. In that case unwind the coil and
rewind it in the opposite direction.
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Electroscope: Push a thick wire through the cork stopper of a jag or bottle. Bend
the wire so that a hook is formed and place a piece of aluminum foil over it. Lower the
wire in jug until you can cork the jug. Any charged article brought near the open end of
the wire will make the foil react.

A Simple Thermoscope: Fit corks and glass tubes in two used light bulbs and fix
them on a wooden board as shown in the figure. Connect the open ends the glass tubes
with rubber tubing. Blacken one bulb. Remove one bulb and pour any liquid into the
U-tube until about 7 cm above the base board. Replace the bulb and slide the tube in or
out a little so that the liquid is at the same level. Place a lighted candle in the middle of
the two bulbs and see the effect on the level of the liquid.

A round bottom plastic vessel used as water container (water pot) can be improvised
as a globe with suitable lines and colours.

A used up Refill, can be improvised and could be converted, used to drop the
stains during microscopic mountings.
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27.3.4 Merits and De-Merits

The details with reference to the meaning, nature and importance of improvised
aids, might have created in your mind. All those could be considered as merits of
improvised aids. But remember, this also is not free from demerits. So, while you jump
into such creative activity, you must know merits and demerits, its pros and cons very
well as improvisation cannot be a panacea for all the educational problems. Therefore,
let us first list out the merits of improvised instructional aids.

Merits:

• It is the best measure to overcome the problems of low economic status and
instructional aids enhancing learning among the schools.

• It inculcates the value of dignity of labour, in which both the teacher and the
taught will be handling the so called wastes and un-wanted materials, and making
the re-use possible.

• It gives a very good social forum for the students to share their ideas, creativity
and responsibility with a team spirit.

• It is a thrilling experience, for the students in which, whatever they learn will last
for a longer period.

• While assuring the efficiency and effectiveness to the teaching-learning sessions,
it assures a sort of “belongingness” and “oneness” among the individuals.

• Such types of activities are actually the culminating point in which, student’s head,
heart and hands get coordinated.

• Improvisation of aids is the best opportunity for self-learning. Children will be
facing it as a great challenge both for their mental ability as well as their energy.

Demerits:

• Whatever may be the result improvised aids also, sometimes need money. The
question comes like, who has to pay for this? Reluctance of teachers and
administrators may not find it interesting; then the whole philosophy behind such
activities fail.

• All the teachers and pupils may not be very skilled in preparing such instructional
aids. Under this situation, it will be simply a pressure or burden on the teachers
and the student.
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• It is time consuming. And there will be no special provision for such activities
with due weightage in the time table.

• There is a need to get trained first, so that, improvisation of aids is possible at its
best level. Hence, appropriate training in the development, production and utilization
of low-cost educational materials as well as improvised instructional aids, should
occur in priority.

• Check on the internet. You will find amazing ideas to enrich your learning aids.

‘Check Your Progress’ -1

State whether the following sentences are ‘True or false:

1. Waste is a waste

2. Improvisation of instructional aids means repairing the broken ones.

3. ‘Improvisation of aids’ - is against to purchasing learning aids.

4. Improvisation of aids is similar to re-cycling and re-using technique.

5. To prepare improvised instructional aids, a laboratory is needed.

Fill In The Blanks:

1. Improvisation of aids is possible irrespective of ………………….

2. The process involved in the production of improvisation of aids is……….

     and .................

3. Improvising aids is a ........................... job.

4. The common solution used for the preservation of organisms is ……….

5. The activity of improvising instructional aids inculcates the value of ………....

27.4   Let Us Sum Up
To bring about a quality improvement in the teaching - learning process, several

instructional aids are used. But sometimes, one may not find or get any one, relevant
instructional aid at least. It may be because of the poor economic status of the schools
also. Such incidents are not rare in India. Improvisation of aids is one of the several
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ways to overcome the above said problems. The Philosophy behind this is “A waste is
not a waste” And “Nothing is a waste”. It emphasizes the repair of broken or un-
wanted equipments with minimum expenditure and insisting their re-use. Such aids
are also known as low-cost educational materials. In this process both the teacher and
the taught get involved actively. It is possible in all the subject areas. Like, preparing or
repairing the old charts, maps, globes and other certain working models also. Usually,
unwanted bottles wire mesh, glass jars, etc., are used in the Biology to keep plants,
insects and other non-dangerous animals for observation. Any vacant or empty refill of
a ball pen can be used as a stain dropper during microscopic mountings.

The activity of improvising instructional aids has several positive points, like, it
inculcates certain social values, namely, dignity of labour, belongingness, oneness,
togetherness etc;. It makes the students learn and take up social responsibilities. It tries
to provide the best service with minimum or no expenditure basis.

27.5 Answers to ‘Check Your Progress’
‘Check Your Progress’- 1

1. 1.  False

2.  True

3.  False

4.  True

5.  False

2. 1.  Any subjects

2.  Simple and inexpensive

3.  Challenging

4.  Formalin

5.  Dignity of labour

27.6 Unit-End Exercises
1. What is meant by “Improvised Aids”?

2. Explain the need and importance of instructional aids.



371

3. What are the merits and demerits of improvised aids?
4. Illustrate the concept of improvised aids’ with any two examples.
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28.1 Introduction
Instructional aids could be as simple as charts, maps and globes. It could be as

complex as a computer, overhead projector and slide projector etc. You can find a
categorical difference between the above said types of instructional aids. The first
category does not depend upon any power supply, and they are easier to handle. These
do not demand any technical knowledge or a perfect technician. No doubt, that a teacher
can use both the types, but the latter ones may pose some technical problems while
using in a class room situation. Hence a teacher must know some of the technological
aspects of such instructional aids. So, in this unit you will get detailed information
with respect to technology based instructional aids, namely overhead projector (OHP),
Slide projector, TV and other electronic gadgets. The advantages of such aids and the
mode of their usage also shall be discussed.
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As has already been pointed out, all the instructional aids are broadly classified
into two types as, Technology dependent instructional aids and Instructional aids that
do not depend upon technology in general and projectors in particular. So, Overhead
projectors, slide projectors, and TV are obviously, technology dependent instructional
aids. These machines will work as the instructional aids by a good combination of their
hardware and software parts. So, machinery parts may confine to hardware section,
where as the information on, like, electromagnetic tapes, cassettes, CD etc; are said to
be software. A teacher must know how to use the machines and how to maintain such
machines. Apart from this, a teacher also should know the preparation of software
parts, namely, transparencies, cassettes, slides, etc. It is because, the transparencies,
slides or CDs relevant to certain concepts to teach may not be readily available, and
therefore, if you know the procedure for such preparations, then your knowledge could
be best utilized.

28.2 Objectives
After studying this Unit you will be able to:

• Explain the meaning of an Overhead Projector

• List out the advantages of an Overhead Projector

• Describe the procedure of maintenance of an Overhead Projector

• Explain the procedure for the preparation of transparencies

• Explain the meaning of Slide Projector

• List out the advantages of a Slide Projector

• Explain the procedure of maintenance of a Slide Projector

• Explain the procedure for the preparation of slides

• Mention the advantages and uses of VCP, TV and Video cassettes

28.3   Overhead Projector
Overhead projector is one among the projected aids. This will become useful under

the condition of a constant power supply. That is to say, all projection equipment requires
electric power for operation. It can project the diagrams that are on transparencies,
with a bright and magnified size. On transparencies, any figure, diagram, statistical
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information, tables, etc; could be drawn, and projected by using OHP. The projected
diagram on the screen or upon a white wall before the students in a class becomes one
of the best instructional aids.

28.3.1  Meaning and Advantages of OHP
The name ‘Overhead Projector’ itself conveys the meaning of the device. It is so

named, because of the fact that the projected image is behind and over the head of the
speaker. Ina overhead Projection, a transparent visual is placed on a horizontal stage on
top of the light source. The light passes through this transparency and then is reflected
at an angle on to the screen at the back of the speaker,

The Design of OHP: It consists of a strong source of light, reflector (concave
mirror), condensing lens, slide carrier and objective lens. All these elements are contained
in a light weight metal case.

It contains an area of vertical projection besides the straight horizontal path of the
light available with the usual projectors. The path of the light rays is again changed to
a horizontal one by a mirror placed at 45° angle and continues over the shoulder of the
teacher to the screen as may be evident from the diagram given below.
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• It contains a large aperture of the size 25 x 25 cm or 20 x 20 cm for placing the
slides and other visual materials.

• It provides for the focusing of the image on the screen by vertical movements of
the projection head (containing the objective lens and mirror).

• There is a provision of constant flow of air past the lamp by a cooling fan in the
base of the projector.

Advantages of Over-Head Projector: Overhead Projector is far better when
compared with other two - dimensional, non - projected instructional aids. With suitable
transparencies, an OHP seems to be an effective and efficient device for the presentation
of any information. So, now let us list out the advantages of the Over-Head Projector.

• It makes the teaching process quite illuminative, illustrative and impressive. Even
in the illuminated room, it could be operated. Therefore there is no need of darkening
of the room.

• It saves the time of drawing the diagrams on tile board and also, a good transparency
prepared at leisure well in advance gives confidence for teachers.

• The transparencies once prepared can be preserved for the re-use.

• The image is projected over the shoulder of the teacher; therefore, he may face the
class all the time.

• It allows the teacher to use the screen as a “black board”. He can write on the
transparencies, with a marker pen, or wipe off etc. Any opaque sheet can hide the
portion of a diagram, and the teacher can make use of this opportunity to explain
any diagram step by step by projecting a portion of the diagram as he wants.

• If he uses a pointer on the slide, it gives a more effective explanation. He need not
turn towards the screen and locate the parts of a diagram.

• The operation of the OHP is quite easy. It simply demands turning of the power
switch, placing of the slide on the projection stage and focusing of the image on
the screen.

28.3.2  Maintenance of OHP

Overhead Projector needs a very careful handling. And a few aspects are to be
kept in mind in order to maintain an OHP in a good condition. Those aspects could be
listed as follows :
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• The projector should not be subjected to mechanical vibrations.

• A voltage stabilizer is a must to avoid the bad effects of voltage fluctuations.

• Halogen lamps particularly will not withstand heavy surge in voltage. The lamp
should not be touched by hand.

• OHP should not be kept in operation continuously for long periods.

• The Fresnel lens is protected by a glass plate on top. It is necessary to remove dust
or dirt on the protecting glass and also from the outside lens surface by flat camel
hair brush.

• Surface silvered or aluminized reflector should not be cleaned.

28.3.3  Preparation of Transparencies

The overhead projector is useful only by means of transparencies; otherwise, it
becomes just a machine. But there transparencies will be available as blank sheets, on
which the required diagram, table or any information has to be drawn or written. Hence
you must be aware of the procedure for the preparation of transparencies. These
transparencies could be prepared by any of the following four methods.

Hand - drawn Transparencies: The acetate sheet is placed over the paper and
kept in position by paper clips or pins or self-adhesive tape. The sketch is carefully
traced using a marker pen or sketch pen with quality Indian ink. Water colour impressions
and brush pens also could be used. But the water colour impressions could be easily
erased. Hence, if the transparency is required for permanent use, the impression carrying
surface should be protected by either clear varnish spray or keeping acetate sheet
over it.

Acetate sheet may be coated with good quality gelatin. About 5 gms of gelatin is
dissolved in 25 gms of water by boiling. The solution is applied evenly with a flat
brush on acetate sheet. On the coated side, it is to draw with good quality Indian Ink.
The sheet can be coloured using transparent water colour.

Photographic Transparencies: Employing reflex printing process, negatives on
reflex printing paper can be made complicated diagrams or rare pictures printed on
books or composed diagrams using Indian ink. With these negatives, positives can be
printed on sensitized dia-positive acetate. The acetate film is available as sheets of 10"
x 12" or rolls. The picture can be coloured using transparent water colour. The dia-
positive acetate sheet also can be used as bromide paper and direct enlargement made
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on it from any photographic negative using an enlarger. The enlargement can be coloured.

The Diazo Process: To make a large number of copies of transparencies, diazo
chemical coated acetate can be used along with master drawn on translucent paper.
The two are kept together exposed to sunlight or ultraviolet source for a suitable time
(2 to 3 minutes). The image will develop on exposure to ammonia vapour. Beautiful
coloured overlays can also be prepared by this process.

Copying Machines: Copying machines produce the positive and negative
transparencies from the original material. In the infra-red copying machine, the
transparency film is placed in contact with the original. The exposure dial is adjusted
to provide desired image density. The original and film are fed into the machine and in
just 4 seconds, a transparency can be obtained in black and white. OHP transparencies
may be made easily and quickly by such thermographic processes. (eg.: using a copier
like Xerox)

‘Check Your Progress’-1

1. Technology dependent aids are characterized by

a) Machines and power supply

b) Techniques

c) Machines

d) None of the above

2. While using an OHP a teacher can explain

a) Turning towards the screen and pointing the figures or diagrams

b) Facing the students as well as pointing at the diagrams or figures on the screen

c) By standing at one end of the class room and pointing towards the figure or
diagram on the screen.

d) None of the above

3. State whether the following sentences are True or False:

a) OHP allows a teacher to use the screen as a “blackboard”.

b) While using OHP the classroom must be devoid of light i.e. the class room
must get darkened.

c) The Projectors should not be subjected to mechanical vibrations
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d) OHP should not be kept on continuously for long periods.

e) One cannot get a hand — written diagrams on the transparencies.

28.4  Slide Projector
Slide Projector is yet another projected instructional aid. It could be worked with

the power supply. Similar to transparencies in OHP, slides are used as software part
here. So, in the following discussion you will come to know about the meaning and
advantages of slide projector, and the procedure for the preparation of slides.

28.4.1 Meaning and Advantages of Slide Projector

Slide Projector is used to project the slides. Here the slides are projected by an
instrument equipped with a powerful light source in a lamp house and carrier for holding
slides of suitable sizes. It is a simple mechanism and the essential elements in it are the
same as in a film strip projector. Usually a double slide carrier is fitted into the projector
so that when one slide is projected on the screen, a second slide can be kept ready.
When the class views the second slide, the first slide can be removed and another
inserted in its place. There is a “thumb mark” or guide marker on the upper right hand
corner of each slide. Most 2" x 2" slide projectors today use drums or cartridges in
which many slide can be loaded in proper sequence in advance. The projectors can be
operated and focused by remote controls. It is also possible to record the narration in a
tape-recorder and the latter may be hooked up to the projector in such a way as to give
necessary commentary even in the absence of a teacher. This is said to be Slide - Tape
sequence.
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Advantages of Slide Projector

The slide projector is quite handy and portable with several advantages. Now let us list
out the advantages of slide projector.

1. It is light and easy to transport

2. It is non - fragile and non - inflammable

3. It is available on moderate expenditure

4. Availability of projector with low voltage lamps or petromax lamps making it
possible to use the same even in non - electrifies areas.

5. Complete darkening of the room is not absolutely necessary. There may be sufficient
light to enable the pupils to take notes.

6. The projected image has greater power to catch the attention of the pupils.
7. Varieties of information may be given incorporating maps, drawings, photographs

etc, through the slides. The teacher can give suitable commentary making use of the
books or can record the commentary on a tape and replay it during the use of a slide
projector. Further the pictures can be retained on the screen as long as necessary.

28.4.2 Maintenance of Slide Projector

Slide Projector like any projector needs a Careful handling. The machine has to be
maintained properly. Therefore we shall try to list out the factors that result in the
maintenance of the slide projector. The machine needs a still platform while it is used;
and it should not be subjected to mechanical vibrations.

Like in any electronic gadgets usage, here also a stabilizer is needed, which could
avoid the adverse effects of the power supply fluctuations. Any sort of exposure moisture
should be avoided because this may result in fungi attack, and there by spoiling the
machine or rusting of the iron parts.

• It must be always dust and dirt free. This is the most important aspect.

• It has to be used often and often, so that the machine will remain in a good condition.

• Proper use and keeping it back in the position after the use is also important.

28.4.3 Preparation of Slides

In order to prepare the slides one has to follow several steps. These steps have
been explained below: First select a suitable topic from the syllabus after considering
the possibilities of depicting the subject - matter by drawings, diagrams, photographs
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or still pictures etc; Then prepare of detailed script, describing the contents of each
frame indicating the method of preparing it i.e., whether by art work or something else.
Make rough sketches of the figures on the paper so as to serve as guide when final
sketches are drawn. Draw the sketches in suitable sizes on white drawing paper with
Indian Ink to suit the 2" x 2" slides then reproduce the same on the slides. Arrange the
drawings and photographs according to the script and number them in sequences. Prepare
the guide book which is to follow the slide sequence explaining the details of each
frame. The commentary may even be recorded on tape and it may be used in combination
with the slides. An audible signal like the stroke of a bell recorded with the commentary
may indicate when the next frame should be shown.

The general procedure of making simple slides may be outlined as under:

● Try to select the base material for preparing slides. It can be plain glass, cell -
plane, etched glass, a clear transparent cellulose acetate film.

● First of all a rough layout is laid down. For this purpose, the outline of the projection
areas is to be marked off on the tracing paper. Then the basic illustration is to be
sketched and other symbols or lettering is to be positioned according to plan.

● Now a sheet of transparent base material (glass or cellulose acetate etc.) is placed
over the original sketch or layout. A drawing pen or marking pencil is used for
tracing the figure, art work or lettering directly on the transparent sheet.

● For better illustration, one can add colour, symbols and patterns by use of any
pencils, inks, tapes and coloured adhesive sheets.
Photographic slides can be produced with the help of suitable camera by taking

photographs of the objects or events. The process begins with exposure. After exposure
the photographic film is developed and printed on a transparent glass plate. After its
development, the positive print is covered with glass are taped together along the glossy
edges and the slide is ready for projection.

‘Check Your Progress’ - 2

1. Slide Projector is

a) Over-head projector

b) Non - Projected aid

c) Made up of a series of slides

d) None of the above.
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2. A slide projector usually will have

a) A double slide carrier

b) A triple slide carrier

c) No slide carrier at all

d) None of the

3. State whether the following sentences are True or False

a) The Projectors can be operated and focused by remote controls

b) Slide projectors are very heavy and it is very difficult to transport

c) Slide projectors can be used even in non-electrical areas

d) The machine should not be exposed to any sort of moist

e) Preparation of slides includes the preparation of the relevant guide     books
also.

f) Each slide will have some information which is termed as “frame”.

28.5    VCP, TV and Video cassettes - Advantages and Usage

Television : Television is another technology dependent instructional aid which
attracts both the senses, namely auditory as well as visual sense of the learners. Hence,
it is considered as very powerful device in the transmission of knowledge. The successful
placing of the satellites into orbit, has added new dimensions in the use of television
for instructional purposes. A regular educational service (EDUSAT) for schools and
college students in the shape of model lessons and other instructional programmes can
now be seen on the TV screen. Television with a slight modification can be converted
as CCTV i.e. closed circuit Television. The close circuit television broadcasting is a
sort of micro level local arrangement limited to a single school or several schools lying
in a particular region. It is connected by a cable or micro wave system. This telecast
exclusively restricted to the terminals which are connected by a network. That means,
the telecast cannot be received by other sets outside the selected network. Anyhow,
you cannot deny but just accept that, Television is a powerful agency of communication.
Live programmers and motion pictures can be broadcast in television. Television has
all the advantages of a projected aid and dynamism of motion picture. Television provides
multimedia learning experience. Since the programmes are announced earlier, the
institutions can prepare the pupils in advance to view and listen to the telecast.
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Many telecasts, in addition to programmes exclusively for schools, can be
considered educational in a general way and viewed by pupils with advantage. Hence
Educational Television (ETV) includes programmes whose primary interest is to educate
rattler than entertain. ETV generally includes instructional television and non -
commercialized television programmes.

 Instructional television (ITV) includes programmes related directly to an organized
programme of formal instruction and is directed to individual viewers who come under
non-formal education programme. In all these cases, suitable follow - up work by the
teacher is essential to consolidate the gain of knowledge. Education through television
involves careful planning Training of teachers to make the best of the equipment and
programmes telecast is necessary. The centre for educational technology of the NCERT
has launched such training programmes of resource persons drawn from the ranks of
teachers of primary schools, who will in their turn, train further teachers.

Video Cassette Player (VCP): Some times pre-recorded video tapes can be
played through television in the classroom. Video films on educational topics shown
through television in the class room have the same effect on the students as the
ordinary cinematic educational films do. Video films have the added advantage over
ordinary films in that the arrangement is compact and requires little space and time
for manipulation. It is the most convenient of all audio- visual teaching - learning
materials.

Video Cassettes: These are very popular electronic devices now a days. They have
equally spread over both in the field of education as well as entertainment. The potential
advantage of video cassette lies in the fact that control of the equipment and the learning
process is placed in the hands of the learner through control over the mechanics of the
machine i.e., stopping, starting, timing, reviewing and previewing and consequently
the capacity to order the sequence of events, controls the rate of learning, and facilitates
practice sequences.

The potential exists for providing the basis for learning wide range of motor,
intellectual and cognitive and interpersonal skills as well as affective aspects. Only the
text book or any other printed material cannot deal satisfactorily, as it could be with a
television, video cassettes and VCPs.

In some countries, video cassette programmes are being bult round the study centre
concept, a location where several video machines are available to which students bring
their study notes. The students run the programmes as individuals. Sometimes study
centres provide for group sessions during which video cassettes are played.

In other countries some institutions assure that students can gain access to such
equipment and make programmes which will be used on an individual basis either
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supplementary learningmaterialorintegral to the teaching programme.
The problems associated with television programme production are:

a. Cost of production of programmes.
b. Equipment costs cannot always be kept down by using lower quality equipment.
c. Cheaper equipment formats do not enable technical material such as animal or

plant tissue to be represented adequately.
d. Video production for educational purposes calls for new techniques different from

the entertainment modes. Producers, directors, script-writers need to be
knowledgeable about teaching and learning. Many of the old techniques of film
and television will a longer be useful. For example, the very basic concept that
programmes must have a beginning, middle, and an end will no longer apply as a
cassette could just as easily consist of a series of short video events which sets a
problem, teaches a technique or brings together a range of visual material to make
concepts or principles clear.

Advantages and Uses :
• Television is considered as the best instructional aid, because it warrants visual as

well as aural sense organs there by making learning a very smooth process.
• It can help the teacher in several ways, starting from his professional growth to

bringing quality learning among the students.
• Television brings cheerful learning experience blended with entertainment among

the student. They can view and hear the work and talk of an eminent educationist,
renowned teacher, creative scientist and excellent demonstrator, musician or artist.
Their presence on the TV screen may provide them clue warmth and nearness for
drawing maximum educational and psychological advantages.

• The instructions imparted through television have the potentiality of improving
the process and products of learning as they involve thorough planning, systematic
presentation and integration of a wide range of audio - visual material and appliances.

• Televised programmes prove helpful in upgrading the curriculum and enriching
the educational programme more easily and economically.

• Any information from any nook and corner of the world can be displayed as a five
programme with reality. This could be used in the class room teaching.

• The expertise and the talents of good teachers from any part of the world could be
electronically stored and used through tele-programmes, so that shortage of good
teachers, classrooms, audio - visual aids and other resources may be overcome
through such planned televised programmes, to some extent.
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• Television instructions may bring greater equality of opportunity for all pupils.
For example, the pupils studying in remote rural or under- privileged areas may be
equally benefited by the TV Programmes.

‘Check Your Progress’ - 3

1. Television is considered as:

a) Visual aid

b) Audio - aid

c) Audio-visual aid

d) Learning aid

2. When several televisions inter connected by means of a closed circuit in a particular
area, the system is called ——————

a) Educational TV

b) Instructional TV

c) Close Circuit TV (CCTV)

d) None of the above

3. The potential advantage of video cassettes lies in the fact of control of the equipment
and learning. Process can be manipulated by

a) The teacher

b) Student

c) The parents

d) Elder persons

4. Video cassettes provide an opportunity to display the educational programmes for

a) Only one time

b) Two times

c) Multiple times

d) None of the above

5. The organisation which caters for the training of teachers with respect to planning
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and execution of educational tele-programmes is .........................

a) State government

b) Central government

c) NCERT

d) NGO

28.6   Let Us Sum Up
In this particular unit you have come across detailed information with respect to

technology dependent instructional aids in general and Overhead projector, slide
projector, VCP, Television and video cassettes in particular. In all these items, the
machines will work as instructional aids by a good combination of their hardware and
software parts. Overhead projector and slide projectors are the best visual aids. In case
of a overhead projector, the magnified diagram will be behind the teacher, so that a
teacher can face the class without turning towards the screen, but can make the students
to observe the exact parts of a diagram by directing them. It makes the teaching process
quite illuminative, illustrative and impressive. While using an OHP, there will be no
need of darkening of the room. Details regarding different methods of preparing
transparencies are also discussed. Slide Projector is yet another projected instructional
aid. Being a light, non-fragile, portable machine it will be very advantageous to teach
with the help of a slide projector. Here complete darkening of the room is not absolutely
necessary.

So, with sufficient light, students can easily write or jot down some points. Television
has surpassed both the Overhead projector and slide projector in so many ways. But it
has its own demerits also. Anyhow, the televised programmes through instructional
television and education television are very much appreciated by professionals. It enables
one to make use of live programmes and motion pictures by means of broadcasts in
learning experience. Any information from the nook and corner of the world can be
displayed as a live programme with reality. This could be shared by the students in the
classrooms. The expertise and the talents of good teachers from any part of the world
could be electronically stored and used through tele-programmes, Televised programmes
are actually considered as a strong means in bringing equality of opportunities for all
pupils belonging to different strata of society.
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28.7  Answers to ‘Check Your Progress’
‘Check Your Progress’-1

1. a) Machines and power supply
2. b) Facing the students as well as pointing the diagrams or figures on the screen
3. a) True

b) False
c) False
e) True
f) False

‘Check Your Progress’- 2

1. c) Made up of a series of slides
2. a) A double slide carrier
3.     a) True
        b) False
        c) True
        d) True
        e) True
        f ) True

‘Check Your Progress’- 3

1. c) Audio - visual aid
2. c) Closed circuit TV (CCTV)
3. b) Student
4. c) Multiple times
5. c) NCERT

28.8 Unit-End Exercises
1. What is OHP? What are its advantages?
2. How will you prepare the transparencies to teach a particular concept?
3. Mention the factors that help the maintenance of slide projector
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4. What are the educational uses of TV?
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29.1  Introduction
The quality of education is always determined by an efficient and effective set of

learning outcomes. To achieve this goal the teaching process in general has undergone
tremendous modifications. Here the quality of learning has become more important
than the quantity of learning. It is more important to know how much a student has
learnt than how many have learnt. This implies that, a teacher must give individual
attention while teaching. But practically this appears to be a Herculean job. Hence a
teacher with other support systems, namely, audio - visual aids can try to achieve the
above said goal. In the previous units you have come across the information with respect
to audio - visual aids. In this particular unit you will learn about a very special device,
what is known as COMPUTER, and its role in teaching- learning process.

Very strongly, now - a - days, it is felt by each and every one that, advancement of
any society or nation depends upon the quality of education being imparted there. In
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turn, the quality of education demands, the adoption of modern and easily understandable
techniques of teaching. In this context, computers are fast becoming effective and efficient
devices in teaching - learning process. Computers, if used properly, can help to teachers
and students in several ways. For example, they can take over the most of the drudgery
of schooling like, classifying children according to abilities, time-table preparation,
etc., They can provide direct interaction between student and the subject matter to be
learned; even they can engage the students in tutorial interaction and dialogue. Usually,
it is observed that, students spend varying amounts of time and practice to achieve
mastery of specific instructional objectives. So, computers used as an aid while teaching,
are considered, as instructional aids. A computer is the best instructional aid, because
it gives a multi - media approach to teaching - learning process. Hence in this particular
unit, we shall discuss on the topic, ‘computers as instructional aids’, interactive software,
its meaning, need, importance and uses. We shall also focus on the development and
presentation of power point slides, as well as techniques of using an LCD and its
advantages.

29.2 Objectives
After studying this Unit you will be able to,
• Explain the meaning of “computers as instructional aids”
• Justify the need and importance of Interactive Software
• Explain the procedure for the development of Power Point Slides.
• Describe the techniques of Power Point Presentation
• Mention the advantages of LCD

29.3 Computers as Instructional Aids
Although a computer can be used in many ways in the educational programmes, the
following are some of the areas where it proves to be effective in the instructional
process. They are:
• Drill and practice
• Tutorial dialogue
• Simulation and games
• Information handling, etc;

Alongside the specific examples of application of computers in education, different
terms are used with specific purposes, For example, terms like, computer assisted or
aided learning (CAL), Computer assisted / aided instruction (CAI), and computer
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managed learning (CML). These terms are used by different authors in different context.
Indeed every author seems to have his own definitions and classifications for some
technical terms. Anyhow computers have been considered as very effective instructional
aids, though they intervene in almost all the aspects of the educational field. Most of
the time, computers are used to provide individualized learning situations to the students.
This type of activity is termed as computer assisted instruction. Computer assisted
instruction has its origin from programmed learning. This is a form of individualized
instructional where a student works at his own pace through written material displayed
usually on the computer terminal.

The computers are influencing the school field like anything. They perform a dual
task, like; they expose students to modern technology and also inculcate in them a new
and scientific approach to leaning. Computers have touched upon almost all the nook
and corner of the educational development, administration and management, educational
planning, documentation, scoring and processing of examination results, researches
and surveys.

Apart from the above list, there are certain major areas, where a computer acts
more as an instructional aid, they are:

● It relieves the teacher in many of his/her tedious time - consuming tasks. It makes
the teacher, the students and computer work in close co-ordination.

● The teacher can prepare the course materials, and utilize it while teaching and
help the students in learning.

● Students also can select the course material which will be of their interest and
need based.

● Computers motivate students to achieve aims in an optimal manner.

● Computers can assist in the achievement of instructional aims and objectives by
providing appropriate material for students of diverse capacity and achievement
levels.

‘Check Your Progress’ - 1

1. Computers facilitate ..........................

a) Individual learning

b) Rote learning

c) Good handwriting
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d) All the above

2. Computers play their role in ………..

a) Teaching process

b) Learning process

c) School administration and management

d) All the above

3. Computers are doing a dual work, as …………..

a) Playing the role of a teacher and student

b) Teaching and learning

c) inculcating in them a scientific approach to learning

d) None of the above

4. Computer assisted learning has its origin from …………....

a) Programmed learning

b) Military science

c) The subject mathematics

d) All the above

5. Programmed learning is a type of …………..

a) Team teaching and team learning

b) Individualized instruction

c) Mass communication

d) Regular classroom teaching- learning session.

29.3.1   Interactive Software - Meaning, Need, Importance and Usage

You must know that, a computer is useful only with its loaded software packages.
These software packages could be, of any type, like, system software, operating software,
utility software or user friendly software etc., In this list, you can have one more type,
what is known as interactive software. So, in the following discussion you will come to
know about the meaning, need, importance and uses of Interactive software.

Software is the one, which makes the computer functional. Likewise, interactive
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software will be user- friendly, and provides a two - way communication between the
student and the subject matter. A good interactive software programme will start its
work by identifying the way a student seems to learn best. It can review his past history
of learning and then presents a programme built on his strength. Even it can store all
the information gained from all students who have worked on it. This information may
be re-analysed and, much of the teaching strategies which were not effective may be
rejected and strategies which have succeeded may be continued.

Problem solving experiences also could be given to the students, in the following
manner:

A problem is presented on the screen of the computer. The student responds by
typing relevant related decision on the computer. Based on this, feedback is displayed
on the screen. A new problem is then presented directly related to the feedback to the
learner regarding the previous mode of decision. Again, the student types a choice to
be made involving perhaps four alternatives in a multiple - choice item. Feedback is
again provided to the student on the quality of decision made, as well as new sequential
problem presented on the screen.

In the context of learning, the rapid response to a learner’s action is of particular
benefit as there can be quick reinforcement of good ideas which the learner has and any
misconceptions may be corrected. Many motor skills can only be learnt by direct use of
the equipment concerned. Computer - assisted instruction, being one of the interactive
software, facilitate teaching -learning situations in several ways. It could be used for
drill work or for repetitive review.

The most powerful advantage of a computer is its continuos dynamic activity. A
computer will not become frustrated. Each student using a computer terminal may
experience the learning items. A learner may read a few statements or see a demonstration
on the screen of the computer. He may respond to a multiple - choice or completion
item. Then the computer screen may show a smiling face if the response given was
correct. If incorrect, the student may try again to answer or respond correctly. If here
also, the answer becomes wrong, then, the correct answer is provided on the screen.

So, all the above said points have done two aspects simultaneously, namely, they
have explained you the meaning and nature of an interactive software as well as their
need and importance. Now let us list out some of the uses of Interactive software
programmes.
• With clear directions in a realistic situation the interactive software programmes

creates a high level of interest and maintains it throughout the learning process.

• They can provide information in a very precise but in an effective way.



393

• They are highly individualistic in their nature, so that each and every student can
learn according to his own pace of learning.

• Immediate feedback is the essence of such programmes which further makes the
learning stronger.

• They check up how well a learner understands a topic through questions.

• An interactive programme could be of any of the following type, namely, drill and
practice, simulations and games.

• Such programmes enable the student to make models of real life situations,
formulate and test ideas and hypotheses.

• A computer data bank helps the student to obtain data and process it quickly and
meaningfully.

• A student can take a test with the computer and can obtain immediate feedback so
that he can rectify his deficiencies and improve his learning.

‘Check Your Progress’-2

1. The interactive software provides an opportunity for interaction between ………..

a) The teacher and the students

b) The students and the students

c) The students and the subject matter

d) All the above

2. The computer becomes functional only with the association of …………...

a) Soft wares

b) Machines

c) Subject matter

d) Teachers

3. The best advantage of an interactive software is its …………....

a) Course ware

b) Immediate feedback

c) Interaction
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d) None of the above

4. State whether the following sentences are True / False.

a) Computers cannot surpass the teachers

b) Computers are known for their swiftness and accuracy

c) The computer fails to appreciate the emotions of the students.

d) Interactive software provide one way communication

e) Computers motivate students to achieve educational aims in an optimal manner.

29.3.2 Development of Power Point Slides

Power Point slides have to be developed with proper planning. So, you have to
frame the instructional objectives first. This has to be done with reference to the concept
selected. Like, for example, if the selected concept is “Photosynthesis”, the following
instructional objectives could be framed.

Students will be able to:

• Define photosynthesis

• Give examples for the plants which do photosynthesis

• Explain the process of photosynthesis

• Mention the two phases of photosynthesis

• Describe the Light reaction in photosynthesis

• Explain the dark reaction in photosynthesis

• Compare the light and dark reactions in the photosynthesis

Based on the above said objectives students can first write down the relevant
points to the respective objectives. You can do the clipping of different pictures, use
animation technique and also can give the sound effect during the Power Point slide
preparation. After this preliminary work, you have to do the remaining work on the
computer.

Introduction to Power Point Presentation

When we have to make a sales presentation, present a new product idea to an
audience, PowerPoint can give an effective presentation means. It includes a few ways
to create a new presentation and several different slides, options. Only thing we have to
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do is select most effective options, to present the subject. Power Point offers mainly
three ways to create presentations.

Blank presentations: This is to give an entirely new presentation which we have start
from the scratch.

Using Templates: This gives an initial idea in selecting the look of the document.

Auto-content Wizard: With this option PP (Power Point) leads us step by step to create
a presentation.

Creating a presentation: Click Start > Programs > Power Point > (choose from the
options)> OK

Auto-content wizard: From the PP dialog box click Auto-content wizard, a dialog box
appears. Go step by step from Start to Finish by clicking the check boxes and
choosing from the options.

Or Click File > New > General > Auto-content wizard

Using a Template:

Start > Programs > PowerPoint > Templates (choose from the options) > OK

Or Click ‘File > New > Design Templates (choose from the options) > OK

Blank Presentations:

Click Start> Programs > PowerPoint > Blank presentation Or Click File > New >
General > Blank presentation

Inserting Text into a Slide: Click the Place Holder (Dotted outline box) > Type the
text > Click outside the place holder. Editing the formatting of the text in the place
holder is done in the same way as that we do in word processor programs. We can
insert almost anything like Charts, Tables and Pictures into the place holder in the
same manner as we do in MS Word.

Moving between the slides: When we create a slide, we see only a single slide on the
screen. This view (called as slide view) helps to work on that particular slide. But
when we add more than one slide and want to work on different slides we can
navigate between the slides easily. One way is to use the scroll bar / Page Up /
Down keys. Another way is to use the icons located in lower left corner of the
window. They are:

Slide view: Shows individual slide.
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Outline view: This view gives an outlined overall flow of the presentation and we can
add or edit text.

Slide sorter view: This gives a thumb nail view of the entire presentation.

Notes Page view: This view is to setup speaker notes.

Slide show: This is used for on-screen slide show of the presentation.

Editing Text: Select the place holder in which the text you want to edit is contained
then proceed to make changes much the same way you do in MSWord.

Editing a Chart: Double click the chart. PowerPoint selects the chart and displays the
relevant data sheet make the changes much the same way as you do in MS excel.

To change the chart: Click Insert > Chart > Chart (Now on menu bar) > Type (Choose
from the options) > OK.

After a careful formulation of individual slides if you want to see whether the flow of
the subject is effective or has to be altered, go to slide sorter view and see if you
have to add or remove or rearrange the order.

Rearranging of Slides:

Click the Slide sorter view icon and you come to that view. Click and drag the
slide to the new location. Note: Double clicking on slide in the slide sorter view
changes it to slide view.

Deleting Slides: In slide sorter view, click the slide and press delete.

In slide view, click Edit > Delete or click on the icon representing the slide, which are
displayed on left hand upper corner of the window and press delete.

Changing of fonts on all slides:

Click Format > Replace Fonts (Choose from the options) > OK

Aligning text: Click Format> Alignment (Choose from the options) > OK

To add text: Click Insert > Text box. Click and drag on the slide. To add chart: Click
Insert > Chart

To add a clipart: Click Insert> Picture > Clipart.

To draw on slide: Drawing Tool bar is similar to that of what is in MS word and the
method also is similar for its utilization.

Major look change: So far we have been through editing and formatting of the slides
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on an individual basis. But to change the overall design of the presentation for a
better appearance and effectiveness may sometimes be called for. In that case
PowerPoint offers these changes to be effected without much fuss.

Applying a Design:

Click Format > Apply design (click on the options to get the preview) > Apply

Changing the color scheme: PowerPoint offers only few options in the color scheme
one for the background, one for the text and a set of colors for charts, (however the
place holders have all the options available as that of in MS word).

Click Format > Slide color Scheme (Choose from the options) > Apply / Apply to all.

Using a different background: Click Format > Background (Choose from the options)
> OK

Slide Show: To start and see how the presentation looks on a show,

Click View > Slide show, First slide in the presentation is displayed. Either click on the
screen or press Space Bar to go to the next slide. At the end of the sown PowerPoint
reaches to last view we were in.

Adding Transition effects: Presentations to make it further effective, by inducing special
effects to the slides at the time of their appearance on the screen.

Click Slide Show > Slide Transition (Choose from the options and preview) > Apply

Creating Speaker Notes: During the presentation one might need to have some notes
to speak about the particular slide, which can be created in PowerPoint having
reference of the slide, without any mix-up.

Click View > Notes Page: Notes page is displayed. Type the notes and click on the
next slide and type the text. Repeat the some until you have finished.

29.3.3 Power Point Presentations

PowerPoint presentation has many uses for an educator. For example
PowerPoint presentation is made to accompany an oral presentation. If the goal is

to print out the slides, you might as well use word processing software. Note that you
may decide to print out the slides (without background color) and create overhead
transparencies as a backup, however, on most occasions, you won’t be printing, you’ll
be presenting. This raises the issue of how best to present these slides. You basically
have three choices, and I’ll present them in order of cost, cheapest to most expensive.
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Projecting to a Television Screen

Projecting to a television is the least expensive option. A projection box and a
television are all that you need. Most schools have multiple televisions, some even on
carts for ease of movement and sharing.

When using this system, you will want to think about the placement of the television
and student seating arrangements. One television in a room offers good viewing for
those seated within 10-12 feet of it. In most classrooms, many students sit farther away
than that, so you might want to allow them to move up to watch your presentation.
Also, a television mounted too high on the wall, does not offer a good viewpoint for
students.

To go from the computer to the television, all you have to do is this:
Connect the Focus box to the back of the computer and to power. Connect the

cord to the TV into the Video-In plug. Push the Input button on the television. Now
what’s on the computer screen will appear on the television. So what are the advantages
and disadvantages of this system?

The Pros:

The cost: You need not spend much on Slide presentations that are mostly graphic
images show up very well on a television. Slide shows with a few, large sized words
show up well too.

The Cons:

Slides with lots of writing do not show up well at all. Words can look somewhat
fuzzy. In going from the computer screen to the TV screen, you sometimes lose three
edges of slides-particularly the bottom edge. So you have to create slides with that
awareness.

Projecting with an LCD Panel

An LCD panel connects to a computer and sits on top of an overhead projector.
So, this option lets you project to a large screen. To use an LCD panel, do the following:

Set the panel on top of the overhead projector. Plug into power both the panel and
the projector with a cable (included with the panel), connect the LCD panel to the back
of the computer monitor. What you see on your computer is what is projected to the big
screen. So what are the advantages and disadvantages of this system?
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The Pros:

View work on a large screen. Good for slides high in either graphics or words

The Cons:

Fairly expensive, as school budgets go. The only way to size the screen is to move
the overhead. Focusing is difficult. Just like on most overheads you’ve worked with,
the top and bottom of the screen look fuzzy and only the center of the screen looks
really in focus. The overhead doesn’t have enough bulb power resulting in a dim screen.
You have to get the room dark with all the lights off and curtains closed.

Projecting with an LCD Projector

Using an LCD projector is the best way to showcase your PowerPoint slides.
However, as you might expect, it is also the most expensive. The good news is that
these projectors are getting better and better and that the price is going down, as with
most technology products. To use an LCD projector, all you need to do is this:

Connect the projector to power. Connect the projector to the back of the computer
monitor, using a cable included with the projector. Special attachments for PC or Mac
are included. What you see on the computer will be projected to the screen.

Be aware that these projectors will also display video, so there are cables included
to connect a VCR to the projector. In fact, even on the less expensive models, you can
connect up to two computers and two VCRs to one projector and bounce between then
in a presentation. So what are the advantages and disadvantages of this system?

The Pros:

View work on a large screen. You can easily size the projection to match your
screen size. The focus is a true one, from top to bottom of your slides. The projection is
very bright. You can even have the lights on and the curtains open and still see the
image. Obviously, if you have a less expensive model, it looks better with the darkened
room. Depending on the quality of your projector, you can set up at the back of the
room and project to the front, so students viewing it do not have to peer around equipment.
You can show video, not just computer work.

The Cons:

Even the lamp replacement is expensive. You get up to 500 lamp hours out of one.
After a thorough planning and preparation of the PowerPoint slides, the rest lies

with its presentation. A teacher has to give the proper background explanation before
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teaching the concept. Then, while presenting the concept before the student, the
PowerPoint slides could be synchronized. It becomes a very effective presentation with
the use of an LCD Projector.

Following are the simple steps that you have to follow while doing PowerPoint
presentation:

1. Select ‘PRESENTATION VIEWER’.

2. Select ‘COMPUTER’ & browse for the required file.

3. Select the file & click ‘VIEW’.

4. The file will be projected on screen. You may control your presentation using your

5. Laptop/Notebook.

6. At the end of presentation, click ‘END SHOW’.

7. Press ‘OFF’ on the keypad.

8. Thank you for your cooperation.

The movement of slides could be in two different types. Like you may fix time-
limit, say once in two minutes, the slides successively change themselves or, you can
manually control the slide change by mouse operation or by a remote controller. In
both the cases, the rate of explanation and the PowerPoint slides show should have an
appropriate co-ordination. And you have to keep one thing in your mind that, the class
should have the interaction also. It should not be a passive one-way communication.
You can use the magnified, projected diagrams or tables or any statistical points, on the
white screen, very effectively. Mean while students also can jot down the points or take
down.

‘Check Your Progress’-3

1.  The first step in the preparation of PowerPoint Slides is ……….

2.  The three types in creating PowerPoint Slides are .............and………..

3.  The steps to be followed to delete a slide are ………… and………..

4. A thumbnail Slide Sorter View entire presentation of LCD is given by ……...

5. PowerPoint Presentation becomes more effective by the use of an ………....
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29.4   L.C.D. Projector- Meaning, Advantages
The LCD projector in the lab may be used for instruction there or may be used for

presentations in the main Library or Library Classroom. Occasionally, it is moved to
C-3 for presentations as well. As a general rule, we do not use the projector in individual
classrooms. We own only one, and it is usually need in the lab. Also, the lamp assembly
is delicate and may shatter if the projector is moved while it’s still hot (ie, between
classes to other locations).

When using the projector either in the lab or the library, keep these tips in mind:
The projector should be about 10-12 feet from the screen. Leg locks are on the front of
the projector to adjust the level. Please leave the projector on the cart and move it
carefully. Also, please make sure that an adult moves and sets up the projector, not a
student aide. (The projector costs Rs. 25,000 and lamp assemblies are around Rs. 20,000
each.)

Side Panel

The On/Off switch is located on the side of the projector. Also on the side, you
will notice where one computer and one VCR are connected to the projector. There is
room for one more of each, if you needed that much equipment.

When you turn on the projector, look at the panel on the top of the projector for the
controls. Notice that the light beside the “On” indicator is amber. This means that the
projector is on, but the lamp is on standby. To turn the lamp on for projection, press
down on the standby button (right) until the amber light begins to blink green. The
lamp will come on, warm up, and project to the screen.

The “Input” button allows you to select what you project-either a computer or
video. By default, the system is set up to project the #1 computer in the lab. However,
if you need to show a video, or part of one, turn on the VCR and then click on the input
button until you get to video I and a blue screen. Then push Play, just like with normal
VCR operation.

Notice that you may make the screen size larger or smaller and a focus button
allows for easy adjustments. There are many Menus to look through, but the only one
you will probably use is the Set Up Menu for volume, brightness, and contrast.

When you have finished using the projector, press the Standby button until the
green light begins to blink amber. The lamp will go out immediately but the amber
light will continue to blink and the fan will continue to blow until the projector has
cooled itself sufficiently. This takes from 1-5 minutes, depending on how long the
projector has been in use.
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Note: Do not turn the projector off until the fan has turned itself off. Then you can
safely turn off the projector. If you turn it off prematurely, the excess heat remaining in
the projector may blow up the lamp assembly.

Advantages of LCD Projector

          LCD Projectors provided an immense help to a classroom teacher. It gives an
option to have meaningful picture clippings in terms of PowerPoint presentation.
Students get the main points very easily when it is presented through an LCD.

• A teacher can face the class and guide the students, what point / part of a diagram
that they have to see on the screen.

• A projected diagram can be made still or moved off according to the need felt by
the teacher as well as the students.

• LCD projectors are light weight, handy and easily portable.

• The projected items will have it pleasant brightness, good clarity and hence become
attention catchy.

• Even any video cassettes also could be projected before the class, as it was just
with the computers.

‘Check Your Progress’ - 4

1. LCD projection is .............. expensive

a) Least b) Moderate            c) Most d) None of the above

2. While using the LCD projector, it has to be kept ….. feet from the screen

a) 5 to 10 b) 10 to 12              c)20to25 d)30to50

3. Even if you use the ‘stand by’ button after the projection work, the amber light
continue to blink and the fan will continue to blow for about

a) 1 to 5 minutes b) until the projector gets cooled

c) 10 minutes  d) None of the above

4. PowerPoint Presentation is made to accompany an ……….. presentation

a) Mass b) Classroom

c) Oral             d) All the above
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5. A computer associated with an LCD makes the PowerPoint Presentation more

a) Effective and efficient b) Beautiful

c) Interesting d) All the above

29.5   Let Us Sum Up

Intervention of computers in the field of education is the ‘MANTRA’ of these
days. Here one need not know the hardware part or software programming necessarily,
but should know how to use that as an aid in teaching learning process. Computers are
used in almost all sectors in the field of education. For classroom purposes, they are
used for drill and practice, for simulation and games, as computer aided instruction
etc,. A computer as learning aid gives a highly individualistic and the best quality of
learning experiences. You may find many types of software but for teaching - learning
purpose, it must be interactive software. Of course much has to be developed in this
direction. Here most of the time, the courseware will be in the form of programmed
instructions. Whereas for the presentation of information, PowerPoint slides are the
most preferred one, PowerPoint slides have to be prepared based on proper planning
and also should have a strong base of content analysis. This gets more impressive
presentation through an association of LCD projector. Liquid Crystal Display (LCD),
though quite expensive, is the best one for a classroom presentation. It is so felt because
of its multifarious advantages.

29.6 Answers to ‘Check Your Progress’

‘Check Your Progress’ -1

1. a) Individual Learning

2. d) All the above

3. c) Exposing students to modern technology and inculcating in them scientific
approach to learning.

4. a) Programmed learning

5. b) Individualised instruction.
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‘Check Your Progress’ - 2

1. c) The students and the subject matter

2. a) Software

3. b) Immediate Feedback

4. a) True

b) True
c) True
d) False
e) True

‘Check Your Progress’ - 3
1. Framing the Instructional objectives
2. Blank presentation, using templates and Auto content wizard
3. Slide view, Edit and delete or click on the icon representing the slide
4. Slide Sorter View
5. LCD

‘Check Your Progress’ - 4

1. C)Most

2. b) 10 to 12 feet

3. c) Until the projector gets cooled

4. c) oral

5. d) All the above

29.7  Unit-End Exercises
1. What is meant by “Computers aided instruction”?
2. ‘Interactive software’ are of importance now-a-days Justify your answer
3. How will you develop the PowerPoint slides? Explain in detail.
4. What is LCD? What are its advantages?
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UNIT- 30  ❐ ❐ ❐ ❐ ❐  CO-CURRICULAR ACTIVITIES AS
 INSTRUCTIONAL AIDS

Structure
30.1 Introduction

30.2 Objectives

30.3 Co-curricular Activities

30.3.1 As Instructional Aids

30.3.2 Merits and De-merits

30.4 Let Us Sum Up

30.5 Answers to ‘Check Your Progress’

30.6 Unit - End Exercises

30.7 References

30.1 Introduction
‘Co-curricular activities’, as the term itself suggests, are associated activities,

accompanied with the regular curricular activities. This implies that Co-curricular
activities are not one and the same as the curriculum, but are essential and integral part
of it. These activities supplement the regular curriculum. They fulfill the other non-
academic or non-scholastic activities which otherwise would not take place at all. For
the development of a balanced personality of the child both scholastic and non - scholastic
activities play an equal role. So, in this unit you will come to know about the meaning,
nature, and importance of Co-curricular activities. You will understand that co-curricular
activities also are one more type of instructional aids. At the end, you come across the
merits and de-merits of such activities.

As it is has already been explained co-curricular activities are the best supplementary
programmes that compensate certain lacuna of a regular curriculum. However the line
of differentiation between these two is very thin. Because each experience makes the
child learn something or the other! A few decades back, the same concept was recognized
by the term “Extra Curricular Activities”. This was implying that “such activities are
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of less importance” Hence the term has been replaced by “Co-curricular activities”.
Co-curricular activities contribute for the physical, social, moral, intellectual development
of an individual. Especially these will play an immensely important role for the emotional
development of the individual. These also influence in widening the knowledge, and
cognitive development. Certain scientific hobbies, cultural talents, varieties of clubs,
namely, science club, eco-club, nature club etc; are very well developed under a broader
canopy what is known as Co-curricular activities.

30.2   Objectives
After studying this Unit you will be able to,

• Give examples for Co-curricular activities

• Justify the importance of Co-curricular activities as instructional aids

• List out the principles of organising Co-curricular activities

• Mention the types of Co-curricular activities

• List out the merits and demerits of Co-curricular activities

30.3  Co-Curricular Activities
Co-curricular Activities and Curricular activities are complementary to each other.

Hence both of them focus on the benefit of the students. Co-curricular activities could
be designed based on varieties of objectives. Some experts say that, co-curricular
activities provide a fertile area to utilize the important and significant basic drives and
energy to achieve the broader educational goals. By participating in these activities,
students get prepared for a democratic society. These activities also help the students
develop confidence and ability for self-direction and auto-guidance. It makes them
learn ‘co-operation’. It seems to be a very good means for developing interest in school
activities in general and school in particular. This most significant output could be the
development of a positive attitude for preserving as well as maintenance of law and
order in the society. It is a very good forum for the identification and nurturing of any
special talent among the students. Thus, co-curricular activities encompass a wider
area without disturbing the regular curricular activities. However, these activities prove
themselves more effective, if they are deliberately planned and executed. For this to
happen one should know certain principles of organising co-curricular activities.
Therefore, now let us list those principles one by one.



408

Principles of Construction of Co-curricular Activities

• The activities must bring out the integration of Curricular and Co-curricular
programmes. So, that both of them become complementary and reciprocal to each
other. That is to say, a co-curricular activity should not stand as an isolated piece
from the regular Curriculum.

• If one or two periods are preserved for such activities, then it is better to show that
in the regular time table itself.

• Co-curricular activities must be constructive and creative in their nature. It is true
that, each and every student cannot participate whole heartedly with full commitment
in all the types of co-curricular activities. But still a teacher should take care that,
every student will participate actively in one way or the other, and no individual is
denied. Otherwise it just becomes the show of one or two dominating students or
dominating groups. This has to be avoided.

• While selecting and assigning different responsibilities for such activities, make
use of democratic principles as well as the individual abilities of the students.

• Co-curricular activities must cater to the interest, abilities, and attitudes of the
students. They must go in consonance with students’ interest, competencies and
attitudes.

• It is true that students will get more freedom in co-curricular activities. Hence a
teacher must know that, his role will be just giving the directions and guidance;
and all the rest should be by the students only. And he should take care that; each
student will learn to perform the role of a leader as well as the role of a follower.
They must learn the dignity of labour.

• While planning for novel co-curricular activities, began after thorough discussion,
clarifications with the experts and concerned persons. You must be very clear
with the objectives and method of its execution as well as its associated pros and
cons.

• Any activities for their success, depend upon the administrative support. Hence
the letter correspondence, documentation, maintenance of the budget - etc; have
to be taken care off with due importance. It is not only the administrative support
but also, a sort of supervision that makes a programme grand success. Hence, the
authorities of the management and administrators have to take more responsibilities
in this juncture.

• The activities that are conducted outside the school campus need more discipline
and prior precautions and cautious arrangements.
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• If you are sending competitors from your school to any “prestigious competitions”,
then select the appropriate and suitable’ candidate based on his talent. As for as
possible avoid the political pressure, or any other type of influences.

• Even co-curricular activities also, should be evaluated. Based on the results, rectify
or eliminate the wrong steps and plan with more clarity for further co-curricular
activities.

‘Check Your Progress’ -1

1. A few decades back the ‘co-curricular activities’ were termed as

a) Curricular activities

b) School activities

c) Extra Curricular activities

d) Teaching activities

2. Curricular activities and Co-curricular activities are ......... to each other

a) Opposite

b) Parallel

c) Complementary

d) Vertical

3. Special talents of the students are ............. through Co-curricular activities

a) Identified and nurtured

b) Neglected

c) Hindered

d) Suppressed

4. Co-curricular activities must be ………... in their nature.

a) Destructive

b) Distractive

c) Constructive

d) Non-creative
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30.3.1  Co-Curricular Activities as Instructional Aids

You must not develop an impression that co-curricular activities occur at the
peripheral level and do not lead to learning of the subject matter. In fact, there are
considered as one of the best media of learning. They are used by the teachers as
instructional aids. They can take any form of activities. It varies from school to school
and year to year. Each school will perform a number of and a variety of co-curricular
activities. It could be cultural activities, competitions, hobbies, field trips and excursions
etc,. In all the activities, the main objectives will be educational as well as entertainment.
It could be on AIDS, Environment or Computer awareness programmes. So, to
understand their educational value, let us classify the Co-curricular activities and see
their respective influence in imparting the instructions.

Activities for physical development: NCC, Yoga - classes, sports, Indoor games
and outdoor games - all these will help the students to learn co-operation, execute the
responsibilities and much more than what could happen within the four walls of a class
room.

Activities for civic development: visits to civic institutions like the Gram Panchayat,
Zilla Panchayat, Town Hall, etc; and celebrating national festivals like, Independence
Day, Republic Day, Teacher’s Day etc, and organising Students’ self- government,
mock parliament, mock court etc;

Activities for aesthetic and cultural development: Folk dance, folk - songs, classical
dance, organising exhibition and fancy dress - competition in all the above said activities,
arranging drama or any cultural activities for benefit show will inculcate the cultural
heritage as well as helping nature among the students.

Activities for motor development: Spinning, weaving, tailoring, card-board work,
basket making, flower gardening, kitchen gardening, leather work etc; will make them
to learn as well as earn some thing as a monitory benefit.

Activities to promote literary and educational value: Bringing out school magazine,
debates, quiz programmes, panel discussion, special lectures, guest lecturers symposia
- all these help immensely in developing literary and educational values.

Activities that nurture healthy hobbies: Organising Photographers Club, Eco-
Clubs, Science Clubs, Bird-Watching, etc;

Multipurpose activities (or projects): Beautifying the school, village survey, city
survey, running a dispensary in the school, running a post office, and organising annual
celebrations with a wide variety of activities and functions lasting for a week or so.
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We may sum up, therefore, that co-curricular activities cater to the development
of the child’s entire personality, draw out the latent powers of children varying
temperaments and aptitudes supplement the academic work, socialise the pupil in the
rich social milieu of school - society, and perform the real functions of education.

Objectives

• To achieve the welfare of the school

• To give citizenship training so that the students will become fit to live in the
democratic society

• To develop the qualities of a good leader as well as a good follower.

• To develop harmony between the students and the teachers, among the students,
and through this, developing “Our school” concept

• To integrate the co-curricular activities with the Curricular activities of the school

Organisation:

• Discuss the purpose of establishing a school government with all the students.

• Decide the structure of school administrative committee, number of members,
designation and the mode of selection of discussing with the students.

• Construct the administrative committee

• Prescribing the rights and duties of members and office bearers of the administration
committee.

• Decide the time and how many times the general body meetings should be
conducted, how to execute the work, how it has to be documented, rules and by -
laws of the society, and actions to be taken for the member who doesn’t abide the
rules of the society, deciding the activities that are to be conducted for the current
year, how to lay down the principles, rules and regulation, if need arises, how
these principles could get renewed etc;

• Design the mode of evaluation for the assessment of current year’s activities.

Clubs:
A number of clubs can be started in the school. A co-operative clubs and school

bank can be cited as examples here:
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1.  A Co-operative club: The club is meant for the development of ‘Co-operation’
among the students as it is the result of the co-operative movement. The club is used
for buying stationery, books and other articles. Boys contribute the shares, and from
there shares purchases of books etc; are made. The pupils work as salesmen. Regular
meetings are conducted to decide the selling rates, the amount of new purchases, and
the distribution of the work and the checking of accounts. At the close of the year, the
dividends are shared. The society can also be registered by State Government.

2. School Banks: These teach children to save systematically and to spend
conservatively as there is an incentive to saving and to invest wisely. A convenient
spot in the school building is selected, banking hours are fixed, and the student
accountants manage the bank work. The bank must be under the direct control of the
headmaster. Honesty should be maintained. The bank should be attractive enough to
stir the imagination of the pupils. It should not be too easy to deposit money, but not so
easy to withdraw. But the entire procedure must be known to the pupils.

3. Photography and Motion Picture Club: May be started by some pupils for
recreational purposes. The pupils may learn the use of an ordinary camera and a movie
camera, and operating upon the documentary film machine. The pupils may arrange
the display of document in the villages. Documentaries can be borrowed from the
public relations office, state audio visual unit and the National Institute of Audio -
Visual Education, Delhi. Nowadays DVD’s and CD’s of great academic value are
available. We can choose the best among them for use.

4. School Publications: A varieties of publication could be brought out as school
publications, let as have a look at some of them.

i) News - bulletins : Can be issued by the school weekly or monthly publishing
news about the school (especially regarding sports, tournaments, athletics, debate and
other activities) Humorous skits, cartoons and comments on local news can also find
place in the same. The bulletin can be distributed among the pupils or displayed on the
bulletin board. Arrangements can be made with the local newspapers for printing the
news.

ii) School magazine: It is the chief literary organ of the school. It will contain
literary contribution of the pupils (poems, stories, skits, play, tit-bits, etc). News about
the school activities during the year, information about the functioning of the school,
the results, the changes that take place from time to time and all other matters which
will interest parents, public and higher authorities.
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Organisation: First editorial board has to be selected. This could be for various
sections, like, English section, sports section etc. For such students editors, the teaching
staff (one or two) i.e. staff - editors will give guidance and directions. Guidance must
be given to the students as to what type of contributions will be accepted, and in what
manner they should write. The editorial board should not only select the best, but also
correct the language and the material also, so as to make the same presentable. Care
must be taken that the magazine works as the publication of the pupils and not merely
of the staff. The editorial should give an appealing introduction about the school. The
magazine must accommodate contributions of as many pupils as possible. Proof reading
must be done and the printing mistakes must be avoided. All illustrations and snaps
must be imposing and colourful. The magazine must be distributed among the pupils,
and also presented to the higher authorities and prominent public men who are connected
with the school. Few copies have to be kept in the library section for the documentation
purpose.

‘Check Your Progress’ - 2

1.  State whether the following sentences True / False:

a. Co-curricular activities do not help in teaching process

b. Co-curricular activities have both educational as well as entertainment
values.

c. “School Government” activity leads to the development of “our school”
concept among the students.

d. Sports and athletics activities must be optimized in a school programme.

e. Music, dance and other cultural activities in no way help a student to pass    the
exam - so, they must not be encouraged.

30.3.2 Merits and De-Merits

As you know it, co-curricular activities and their success, highly depends on correct
planning and systematic execution with a good organisation. Hence subjected to
situational factors or any other conditions, these activities are also not free from their
merits and demerits. So, let us focus on this point now.

Merits:

The advantages of co-curricular activities are varied and numerous. Their educative
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functions are so important and necessary that we cannot do away with them. For
example,

• They promote physical development of the students by providing a useful channel
for the superfluous energy of the pupils. For this, sports, athletics, games are
suggested.

• They meet the psychological needs of the pupils Like, they act as agents for the
sublimation of the instincts. They train their emotions. When a variety of activities
are presented, every pupil can find some or other activity that suits his interest and
aptitude.

• They help in the development of qualities of leadership as well as qualities of a
follower. They promote civic value among the students.

• The social value, aesthetic value, the cultural value and the recreational value all
these could be inculcated very well through co-curricular activities.

Demerits:

A number of defects in the organisation of these activities have been noticed, they
nullify the very purpose of these activities.

• It depends upon suitable facilities, like ‘lack of equipment’, may make a programme
hopeless. No progamme of activities can succeed- without proper equipment and
provisions. Some schools have no play ground, no space for indoor games etc;

• Lack of variety: This may be another limitation. Some schools organise the activities
that are the same and repeated. For example, one annual function, one tournament
and an occasional competition.

• Lack of pupil participation: It is a common observation that majority of the pupils
do not take part in their activities. It is because of lack of interest, proper motivation
and encouragement by the staff.

• Lack of adequate staff: Some schools do not possess a full strength of staff even
for academic work, with the result that the sole burden of organizing there activities
falls on the existing staff. The staff members naturally try to shirk work and avoid
the responsibilities.

• Over emphasis on examination is yet another factor which playa dominating role
in weakening the strength of co-curricular activity.
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‘Check Your Progress’ - 3

1.  Mention any two merits of Co-curricular activities.

2.  Mention any two de-merits of Co-curricular activities

30.4  Let Us Sum Up
Co-curricular activities were termed as ‘extra-curricular activities” - a few decades
ago. But now, these have become an integral part of the curriculum and hence term
‘Co-curricular’ activities. By giving this term, we have accepted its existence more
positively, with its educational as well as recreational value. Most of the time these are
utilised as the best instructional aids also. That is why, curricular and co-curricular
activities are said to be complementary to each other. Co-curricular activities could be
designed based on varieties of objectives. This has to satisfy the principles of construction
or organisation of co-curricular activities. These activities facilitate the physical
development, psychological development, civic development aesthetic and cultural
development, motor development, among the students. They also promote literary and
educational values.

Co-curricular activities could be of any type, like, for example, a trip, field visit,
arranging and conducting different competitions, like, quiz, cultural competitions etc;
A school government, different clubs with some purpose etc; could be established. A
magazine could be brought out from the school. So, in this way co-curricular activities
have encompassed a wide educational area, and hence are suitably recognized as
“instructional aids”. However, there activities have to be deliberately planned and
executed. Some of the plus points of such activities can be considered as merits, namely,
promoting physical development of the students, emotional development, developing
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leadership qualities and confidence among the students. As it is they may not pose any
demerits, but certain other factors may make them to appear defective, like lack of
varieties in co-curricular activities, lack of interest among the pupils, hence passive
participation or nil participation, lack of motivation and encouragement from the staff,
over emphasis on examinations, etc; may weaken the strength and effectiveness of the
co-curricular activities.

30.5   Answers to ‘Check Your Progress’
‘Check Your Progress’ - 1

1. c) Extra - curricular Activities

2. c) Complementary

3. a) Identified and nurtured

4. a) Constructive

5. b) Democratic Principle

‘Check Your Progress’ - 2

a) False

b) True

c) True

d) False

e) False

‘Check Your Progress’ - 3

1. Any two merits of co-curricular activities are to be written from section 30.3.2

2. Any two de-merits of co-curricular activities are to be written from section 30.3.2

30.6   Unit-End Exercises
1. What is meant by “co-curricular activities”?

2. Give two examples for co-curricular activities and explain them in detail.
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3. Explain the importance of co-curricular activities as instructional aids.

4. What are the principles that govern the construction of co-curricular activities?

5. List out the merits and demerits of co-curricular activities.
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